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Chapter 1 Quick start of easySCADA

This chapter introduces installation of easySCADA configuration software, including
installation of configuration program and DATABASE SOFTWAER, as well as basic functions
and main characteristics of the software. It also introduces in detail the composition of the
software system and the functions of each object, helping users to understand the overall
structure framework of easySCADA configuration software. In addition, it introduces the
hardware and software requirements of easySCADA, and the installation process and working
environment of easySCADA, helping users to learn use of this software and create application
projects.

1.1 Functions and features of easySCADA are as follows:

1. Complete functions. easySCADA has complete functions, including basic shape drawing,
coloring, text preparation, system picture library, animated display, bitmap status change,
trend picture display, alarm control powerful functions such as dynamic circle, dynamic
rectangle, meter, historical data collection. Designers can easily design schemes and
configuration basing on their own requirements and characteristics of projects, and can
achieve satisfactory effects.

3. Communication. easyMonitor provides drives for communication with PLCs projects of all
ELC and EXM series CPU via RS232, RS485,Ethernet/GPRS. Available protocol is MODBUS
RTU/TCP.

4. Resources. easyMonitor provides abundant resources. The picture library of easymonitor
includes 3D indicator light, 3D button, television, 3D tank, 3D pipe, electron, bars, and the
like. In addition, many pictures are provided with animation properties and can be used to
design vivid animation. It also allows for user-defined picture library and inserting pictures
from Windows. easyMonitor also provides controls that have abundant functions, such as
trend diagram and alarming controls and the like, meeting the requirements of various

configurations.

1.2 Requirements of easySCADA for computer

1.2.1 Software requirements of easySCADA for computer

easySCADA configuration software can be run in the following operating systems:

€ Microsoft Windows NT Server 4.0 or later release;
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€ Microsoft Windows NT Workstation 4.0 or later release;
€ Microsoft Windows 98, Me, 2000, XP or later release.
€ Microsoft Windows 7, windows 8.

': easySCADA will refuse to be installed if the operating system does not meet the above

requirements.

1.2.2 Hardware requirements of easySCADA for computer

The minimum hardware requirements of easySCADA are:

€ CPU: Pentium 3-800MHz as a minimum;

© Memory: When Windows 98 operating system is used, the memory should be 128MB or
above;

When Windows NT operating system is used, the memory should be 256MB or above;
When Windows 2000 or XP ,windows?7, windows 8 operating system is used, the memory
should be 256MB or above;

Graphics card: Compatibility with Windows system, graphics memory of 1MB or above,
allowing for running at 1024*768, 256 colors.

€ Hard disk: The minimum hard disk occupation of easySCADA configuration software is
200MB.

€ Two-key mouse and keyboard.

@J: If the computer configuration is lower than the above requirements, easySCADA is likely

unable to be installed and operated.

Recommended configuration:

€ CPU: Intel Pentium 800 or above, or equivalents;

© Memory: When Windows 98 operating system is used, the memory should be 256MB or
above;

When Windows NT operating system is used, the memory should be 512MB or above;
When Windows 2000 or XP operating system is used, the memory should be 512MB or above;
€ Graphics card: Compatibility with Windows system, graphics memory of 1MB or above,
allowing for running at 1024*768, 65535 colors.

€ Hard disk: Over 200MB.



1.3 Installation of easySCADA configuration software

First part, you need install the *MySQL".

1.Double click
must start the installation as follows:

to startup the installation. But if your OS is win7/win8, you

€ o v 1 & Computer b Local Disk(C) + v| & | | Search Local Disk (€3
-
P Eavorites Name Date modified Type Size
B Desktop .. Perflogs 0712 11:29PM  File folder

& Downloads .. Program Files 012 11:51 PM  File folder
" Recent places 4 Users 1212PM  File folder
L Windows 2/25/201412:12PM  File folder
4 Libraries @ 2/24/204 2:05 AM  Application 15,636 KB
@ Documents T Opea
J’ W Pin to Start
5] Pictures @Run as administrator A_JD
B videos Troubleshoot compatibility
Pin to Taskbar
- Computer Send to »
i, Local Disk (C)
i BD-ROM Drive (D) F ci
e M1 (E) Copy
s M2(F) Paste
ca M3IG) Create shortcut
Delete
i Network Rename
Properties

2. After starting up the installation program, the following language selection box will pop up,
allowing user to select English installation. click "OK”, then the startup dialog will pop up in

several seconds.

Select Setup Language |z|

Select the languaage to uze during the installation:

| E nglizh b |

] J[ Cancel ]

3. In the startup dialog, click Next to continue installation, or click Cancel to quit installation.



ISEE
Welcome to the MySQL6 Setup
Wizard
This will install MySOLE on vour computer,

Itiz recommended that you close all other applications before
continuing.

Click Mext to continue, or Cancel bo exit Setup.

[_ Mext » _][ Cancel ]

4.1n the license agreement dialog, please select whether to accept the software clauses, and
click “next”

el Setup — EySQLG

License Agreement
Fleaze read the following impartant information befare continuing,

Fleaze read the following Licensze Agreement. Y'ou must accept the terms of thiz
agreement before continuing with the ingtallation.

IMPORTANT WOTE:

[

WHEM YOU INSTALL wLogic vOU WILL BE GIVEN THE OPPORTUNITY TO
INSTALL ADDITIONAL SOFTWARE PRODUCTS FROM THIRD PARTY
PROVIDERS. & LIST OF THE AWAILABLE THIRD PARTY SOFTWARE
PROCUCTS 'WILL BE PROVIDED DURING INSTALLATION. USE OF EACH
AyAlLABLE THIRD PARTY SOFTWARE FRODUCT |5 GOVERNED BY ITS
OwN EMD USER LICENSE AGREEMEMNT. THOSE LICENSE AGREEMENTS
/|LL BE PRESENTED FOR *YOUR REWIE' AND 4CCEPTANCE DURING
INSTALLATION OF EACH THIRD PARTY SOFTwWARE PRODUCT.

|

(%) | accept the agreement

(11 do not accept the agreement

[ < Back ][ Mewt > ][ Cancel ]

5.Users can fill in their own personal or company information, or choose the default setting
“C:\MySQL6", and then click “next”.

5! Setup — EySQLG

Select Destination Location

Where should MySOLE be ingtalled? ey o
= =

_J Setup will install MySOLE inta the Following folder.

To continue, click Mest. [f you would like to select a different folder, click Browse.

| [ Browse. ..

At least 55 4 MB of free disk space iz required.

[ < Back ” Mest » J[ Cancel




6. After clicking "Next” in the dialog as shown in below Figure, a dialog will appear to allow
you to choose the installation folder. You may choose the default folder or other folders. Then,
click Next, as shown in below Figure.

ihﬂﬂ Setup — EySQL6

Select Start Menu Folder L
“Wwhere should Setup place the program's shorbcuts?

Setup will create the program's shortcuts in the following Start Mernu folder,

To continue, click Mest, [F you would like to select a different folder, click Erowse.

| [ Browse...

< Back “ MHext » J’ Cancel ]

]‘.;E‘J Setup — H¥SQL6

Ready to Install
Setup iz now ready to beain installing MySGLE on your computer.

Click Install to continue with the installation, or click Back if pou want to review or
change any zettings.

Destination location:
CAMySOLE

Start Menu folder:
MSELE

< Back “ Install |[ Cancel




5! Setup — HySQLE

Installing =
Pleaze wait while Setup installs MySOLE on your computer.

Extracting files...
C:hmyzqletdatahmyzglyproc. frm

llllllllllllllllllllllllllllllllllllllllllllllllll.q

]E.EL Setup — E¥SQLA

Information
Pleaze read the following important information before continuing.
[ = =
=
when you are ready to continue with Setup, click Next
EMD-USER LICENSE AGREEMEMNT FOR THIS SOFTWARE A
Important - read carefully: =
Thiz End-Usger Licenze Agreement ["EULS'" iz a legal agreement between you
[either an individual ar a single entity] and the mentioned authar af this Software for
the software product identified above, which includes computer software and may
include associated media, printed materials, and "online’ or electronic
documentation ["SOFTWARE PRODUCT™. By installing, copying, or othenwize
uzing the SOFTWARE PRODICT, pou agree to be bound by the terms of this
ELLA, If you do not agree to the terms of thiz EULA, do not install or uze the
SOFTwWARE PRODUCT.
SOFTwWARE PRODUCT LICEMSE
The SOFTWARE PRODUCT is protected by copynght laws and international
copyright treaties, as well _aslather intellectual property laws and treatiez. The ~
9




iE;.EL Setup — E¥SQLAG |:|

Completing the MySQL6 Setup
Wizard

Setup haz finished instaling MySGLE on pour computer. The
application may be launched by selecting the installed icons.

Click Finizh to exit Setup.

| <Back || Finish |

10.

11.Then install MySQL connector/ODBC.

i ByS0L Conmector/ODBC 5.2{w) — Setup Wizard

Welcome to the Setup Wizard for MySOL
Connector/0DBC 5.2(w)

The Sekup Wizard will allow wou ko modify, repair, or remove
MyS0L Conneckor/ODBC 5.20w), To continue, click Next,

< Back [ Mexk = ] [ Cancel

10



12.

ji& E¥S0L Connector/0DBC 5.2(w) — Setup Wizard

Program Maintenance ‘

Madify, repair, of remove the program. *

) Modify

Change which program features are installed. This option displaws the
Custom Selection dialog in which wou can change the way Features are
installed,

Repair installation errors in the program. This option fixes missing or
corrupt Files, sharkouts, and registey entries,

Remove MySOL Connector[ODEC 5. 2(w) From your computet.

[ « Back J[ Mext = ] [ Cancel

ji7 EyS0L Connector/ODBC 5.2(w) — Setup Wizard

Custom Setup "!‘
Select the program Features ywou want installed. %

Click on an ican in the lisk below ta change how a Feature is installed.

Feature Description

Installs the MySOL ODBC 5.2.4
Unicode 32-bit driver,

This Feature requires OKE on
wour hard drive,

< Back ”_ Mext = ] [ Cancel

11




ii%l Ey5QL Connector/0DBC 5. 2{w) — Setup Wizard

Ready to Repair the Program =

The wizard is ready to begin installation, 5

If wou want ko review or change any of wour installation settings, click Back, Click Cancel ko
exit the wizard,

Current Settings:

Setup Tvpe:

Deskination Folder:
Ci\Program Files\My3QLYConnector QDEC 5. 2\Unicode),

[ < Back ][ Install ] [ Cancel ]

13.
i"g_.% E¥5QL Connector/ODBC 5. 2{w) — Setup Wizard
Installing MySQL Connector/0DEC 5.2(w) B3
The program Features you selected are being installed. .
Please wait whilz the Setup Wizard installs MyaQL Connector/[CDBC 5, 20w,
This may take several minukes,
Skatus:
Installing ODEC components
[-.u"uu.u"uu.u"uu.HH"".HH"".HH"".HH"".“H ]
= Back Mext =
14.

12



i Ey50L Conmector/ODBC 5.2(w) — Setup Wizard

Wizard Completed

= Back i Finish i Zarcel

15.

4

Part Two: Install “easyScada

1. Double click to startup the installation
2. After starting up the installation program, the following language selection box will pop up,

allowing user to select English installation. click "OK”, then the startup dialog will pop up in

several seconds.

ed

S5elect Setup Language

] Select the language to use during the installation;

L]
e

| Eﬁg":ﬂ:h W |

L Ok J[ Cancel ]

3. In the startup dialog, click Next to continue installation, or click Cancel to quit installation.

13



]‘.;.zl Setup — easyScada

SES

Welcome to the easyScada Setup
Wizard

Thiz will inztall eazyScada on your computer.

Itiz recommended that you cloze all ather applications before
cantinuing.

Click Mext to continue, or Cancel to exit Setup.

[ Mest> '|[ Cancel

4. In the license agreement dialog, please select whether to accept the software clauses, and
click “next”

& Setup - easyScada

Licenze Agreement

Fleaze read the following important information before continuing. e
= =

Flease read the fallowing License Agreement. You must accept the terms of this
agreement befare continuing with the inztallation,

IMPORTAMT MOTE:

[l

WHEM OU INSTALL sLogic v'OU WILL BE GIVEW THE OPPORTUMITY TO
INSTALL ADDITIONAL SOFTWARE PRODUCTS FROM THIRD PARTY
PROVIDERS. A LIST OF THE &WAILAELE THIRD PARTY SOFTWARE
FRODUCTS WILL BE PROVIDED DURING INSTALLATIOM. USE OF EACH
AvalLABLE THIRD PARTY SOFTWARE PRODUCT IS GOVERMED BY ITS
0wk END USER LICEMSE AGREEMENT. THOSE LICENSE AGREEMEMTS
WILL BE PRESENTED FOR YOUR REVIEW AND ACCEPTANCE DURING
INSTALLATION OF EACH THIRD PARTY SOFTWARE PRODUCT.

|.£

(3| do not accept the agreement

[ < Back. l[ Mest » ][ Carcel ]

5.Users can fill in their own personal or company information, or choose the default setting
“C:\Program Files\EASY\easyScada”, and then click “next".

14



&l Setup — easyScada

Select Destination Location
wihere should easyScada be installed?

‘__J Setup will install easyScada into the following folder.

To continue, click Mest. If you would like to zelect a different folder, click Browsze.

i [ Browse. ..

IC:\Program Fi

At least 29.5 MB of free disk zpace iz required.

< Back ][ Mest = ][ Cancel

6. After clicking "Next” in the dialog as shown in below figure, a dialog will appear to allow you
to choose the installation folder. You may choose the default folder or other folders. Then,

click Next, as shown in below Figure.

]',;.EL Setup — easyScada

Select Start Menu Folder
“Where should Setup place the program's shortcuts? i
|-l 8

' Setup will create the program's shortouts in the following Start Menu folder.

To continue, click Nest. If you would like to select a different folder, click Browse.

| l Browsze...

|_<Back J[ MHemut > ][ Cancel

15



& Setup — easyScada

Select Additional Tasks
‘which addiional tazks should be performed?

Select the additional tasks you would like Setup to perform while instaling easvScada,
then click Mesxt.

Additionall cons:
[] CreateDesktoplcon
CreatefuickL aunchl cor

< Back ” Mext » ][ Cancel ]

]',;.EJ Setup — easyScada

Ready to Install

Setup is now ready to begin inztaling easyScada o vour computer.

Click Inztall to continue with the installation, or click Back if wou want to review or
chahge any zettings.

Destination location:
C:AProgram FileshEASY\eazScada

Start Menu folder:
eazpScada

Additional tagks:
Additiohall cans:
CreateJuickLaunchlcon

< Back ]| Irztall J[ Cancel
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i Setup — easyScada

Information

Fleaze read the following impartant infarmation before continuing.

“When you are ready to continue with Setup, chck Mexst.

EMD-USER LICEWSE AGREEMENT FOR THIS SOFTWARE |
Impartant - read carefully:

Thiz End-User Licensze Agreement ['ELLA"] iz a legal agreement between pou ==
[either an individual or a single entity] and the mentioned author of thiz S oftware for

the software product identified above, which includes computer zoftware and may
include associated media, printed materialz, and "online" or electronic

documentation ["SOFTWARE FRODUCT"]. By instaling, copying, or othenwize

uzing the SOFTWARE PRODUCT, you agree to be bound by the terms of thiz

EULA. If you do not agree to the terms of this ELILA, do not install or uge the
SOFTwWARE PRODUCT.

SOFTwWARE PRODUCT LICEMSE
The SOFTwWARE PRODUCT iz protected by copyright laws and international
copyright treatiesz, as well az other intellectual property laws and treaties. The |

FEETLL AR PEEe e ]

10

i'.;,EL Setup — easyScada [_ |

Completing the easyScada Setup
Wizard

Setup has finished instaling easyScada on your computer. The
application may be launched by selecting the installed icons.

Click. Finigh to exit Setup.

| <Back | Finish |

17




L

After that, an icon of “easyMonitor” will appear on the desktop

You can also click “easyMonitor” in “Start”---"All programs”--- “easyScada” to run
easyMonitor configuration software.

: & Set Program Access and Defaults
5 §| Administr e
. W Windows Update
Ink £
“n! E..ma“ 3

(e
ig eayIerver
eazyMonitor

—
|
e Calculabor

@ ‘Wirndows Media Flad
A

. clogicsaft
—
‘! MSh

All Programs B

M Accessories
T Games a
M Rt *
&8 Internet Explorer

W s

¥ Outlook Express

4o Remote Assistance

(=) Windows Media Player

0 WinRar ¥
o EEREELAE || B easytonitor
i) EASY xlogicsoft | BF easyse
& i N o o loction ClPragan Hesigasviess scada
[T EASY eSms Config ¥
) PremiumSoft

Lcn; Off EI Turn OFf Compuber

1.4 Operation of easyMonitor

After installation of SKWorkshop, a shortcut will appear on the desktop, as shown in Figure
2-17:

e

Figure 2-17: Shortcut on the desktop

Meanwhile, easyMonitor program group is added in Start menu of Windows, as shown in
Figure 2-18:
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: &r Set Program Access and Defaults
Administr RN

& Windows Update
- Jtniee

I Accessories
T Games ki

) Rartup *
- #8 Inbernet Explorer
g ceorseree s

¥ Outhook Express
o Remale Assistance

easyMonitor

-:;‘ Ealedater (=} Windows Media Player
T WinRAR ¥
d ) e g B easytonitor

i EASY xlogicsoft ¥
o FERRE C
] EASY eSms Config *
) PremiumScft

Bl easyse

All Programs B

Ln:n; CifF El Turn S Compulber

Figure 2-18: Program icon in Start menu

Double click the shortcut on the desktop, or click easyMonitor in the easyScada program
group in the Start menu to run the software. See Figure 2-19 for the software running page:
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B easyNonitor — [SystemStart]

wlib(L) Layout View Help

s

b B =&[v[[? 2 IO mEEm Bk B
| A7 resie | tnes | B Tine | S Curve | B eter | &5 7ise |
/G000 hbalaBE~ ]
——————— |
123.020] — ]
Evierz
B curveview
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© [ Seript
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2.01-04: @qq1 @qq2 @qq3 @qq4
ELC-12AC-R-N-HMI:

1.192.168.0.177

2,01-04: @12331 @12332 @12333
@12334

Figure 2-19: Software running page

1.5 Editing windows and creating communication connections

easyMonitor configuration software is the configuration visual development system of
easySCADA. As an integrated development environment software it has abundant and
powerful development functions. easyMonitor adopts the advantages of Windows system,
with high user interface consistency and simple interfaces. The layout of the menus is close
to those of Windows system, making it easy to learn, so that project designers can easily
develop suitable configurations for their projects using easyMonitor. The development
interface and the functional areas are shown in Figure 2-26.
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Figure 2-26: Interface and areas of the software

o
*

% Menu bar: Displaying command menus of easyMonitor. All these menus are drop-down
menu.

< Tool buttons: Shortcut buttons of some commands. Displaying corresponding buttons of
file, edit, drawing, and some other functions.

< Picture area window: A window for designers to configure and edit graphs.

< Project manager: Tree menu for window management, device selection,communication
connection parameter setting, kinds of register(I0, Analog I0..) selection.

< Information output window: Displaying prompt messages such as input/output

information and error prompt when the designer are editing and compiling configuration.

o
*

% Status bar: Displaying current configuration status, including coordinate of mouse,
control type, coordinate of control, size of control, and the like.

1.6 Menu bar of easyMonitor

Menu bar of easyMonitor configuration editing software provides users with abundant menu
options, and here you can find almost all tool commands and editing commands required
during configuration. The menu bar consists of File menu, Edit menu, Variables menu,
Drawlib(L)menu, Layout menu, Database menu,View menu, Help menu.And also includes
right click Menus. See Figure 2-27.
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QProject Edit Variables Drawlib(L) Layout Databaze Wiew Help

Figure 2-27
1.6.1 File menu

File menu includes such options as New (Ctrl+N), Open (Ctrl+0), Close, Save(Ctrl+S), Save
As, Print..(Ctrl+P), Print Preview, Print Setup..., User manage and Exit. See Figure 2-28.

o comvonivor_ AT

[)(Project| Edit Variables Drawlib(L)

&l New Ctrl+N &
e Crl+0 | pet
E Close ]ﬁ K
= Save Cirll+s
|ﬁ; Save As..
= Print... Ctrl+P

Print Preview

Print Setup...

User manage
=] Properties...

Compile...

111l.ezpj

Exit
T RS 2 RO SR S] :

New : Used to create a new blank project. The shortcut key is Ctrl + N.
Open :Used to open an existing project file saved in Windows. Project configuration files with
an extension name of “.ezpj” can be opened. The shortcut key is Ctrl + O.

Close: Used to close the current project screen configuration without quitting easyMonitor
configuration software.

Save: Used to save the current screen configuration that has been changed, with the file
name and directory being the same as the original. The shortcut key is Ctrl + S.

Save As: Used to save the current screen configuration, with the file name and directory
being changeable.

Print: Print the widows

Print Preview: Print preview all the windows.

Print Setup: Print setup menu.

User manage: User manage option, user name and password can be set or modified here.
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lser manage A |

Tndex

;

zer Name FPassword zer Priviiege

Tser edit

Properties.. : You can choose the start view and set the time of the database save period.
Please note that the database save period is 1 Minute

F Property . |ij‘

— Start
Start view ISystemSlm |
— Diatabase
Databass save tims |1 Minute ;I
MNote:

Because zach port of the communication speed is different,
the database’s save time is too short, it is possible to casse data
duplication!

oo | e |

Compile.. This menu is used to generate a project package for the end-user.
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Compie m—

Froject file |

C:'\UsershadniniDesktophlll. bin

Project name:

111

Caption:

Version:

|1.|:|. 0.0

Compary: I

Company website:

Fublisher ID:

Output directory |

C:h

Output file name:

easylublish

License file |

license. txt

Create

0%

Compile begin

Click “Compile”..

& Compile

Froject file |

Froject name:
Caption:
Version:
Company:

Company website:

Fublisher ID:

Output directory |

Output file name:

Licenze file |

C:“Usershadmin‘Desktopilll. bin

-
Monitor
Riewtech Froduct System -
1.0.0.0
IRi evtech Electronic.,Co 1td
Iwww. rievtach. com
joa0801
C:'Usershadmin‘Desktop e
IRi evtechMoni tor
license. txt e

Create

Exit I

100%

w
BIL .

defined:

Compile End. . .. ..

Successful compile (5.3A6 =zec). Resulting Setup program filename is:
C:“Usershadmin‘Desktop‘\RievtechMoni tor. exe
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Warning: “CopyMode; alwaysskipifsamecrolder™ is deprecated and ignored in this
wversion of Inmo Setup. It is now the default behawior.



One setup file will be created on your desktop, you can install it on your PC or other PC by
double click.

Select Setup Language m
: L s

@ Select the language to use during the installation:

| Engiish v

ok J[ cancel |

Welcome to the Monitor Setup
Wizard

This will install Monitar on your computer.

It iz recommended that you close all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

[ Nee> | [ Cancel |
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L S I e

Select Destination Location
Where should Monitor be installed?

l Setup will install Monitor into the following folder.

To continue, click MNext. i you would like to select a different folder, click Browse.

“\Program Files (<86)\Scada Publish Browse..

At least 50.8 MB of free digk space is required.

<Back || Med> | [ Cancel |

&) Setup - Monitor =l

Select Start Menu Folder
‘Where should Setup place the program’s shortouts?

I Setup will create the program’s shortcuts in the following Start Menu folder.

To continue, click Mext. if you would like to select a different folder, click Browse.

Browse...

¢Back | MNet> | | Cancel
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@I Setup - Monitor —

Select Additicnal Tasks
‘Which additional tasks should be performed?

click Nexd.

Additionallcons:
CreateDesktoplcon
[7] CreateQuick Launchlcon

Select the additional tasks you would like Setup to perfform while installing Monitor, then

(%) Setup - Monitor

Ready to Install

Setup iz now ready to begin installing Monitar on your computer.

change any settings.

Click Install to continue with the installation, or click Baclk f you want to review or

| Destination location:
C:AProgram Files (c86)\iScada’Publish

Start Menu folder:
iScada

Additional tasks:
Additionallcons:
CreateDesktoplcon

<Back || Instal
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Setup - Monit Ll
S _-— .
Information
Please read the following impartant information before continuing.
When you are ready to continue with Setup, click MNesd.
JMPORTANT NOTE: -

WHEM YOU INSTALL easyScada YOU WILL BE GIVEN THE OPPORTUNITY L4
TO INSTALL ADDITIONAL SOFTWARE PRODUCTS FROM THIRD PARTY
FROVIDERS. A LIST OF THE AVAILABLE THIRD PARTY SOFTWARE

PRODUCTS WILL BE PROVIDED DURING INSTALLATION. USE OF EACH
AVAILABLE THIRD PARTY SOFTWARE PRODUCT 15 GOVERNED BY ITS

OVWN END USER LICENSE AGREEMENT. THOSE LICENSE AGREEMENTS

WILL BE PRESENTED FOR YOUR REVIEW AND ACCEPTANCE DURING
INSTALLATION OF EACH THIRD PARTY SOFTWARE PRODLUCT.

easyScada END-LISER LICENSE AGREEMENT
Redistribution or Rental Not Pemitted -

I@I Setup - Monitor ==

i

| Completing the Monitor Setup
| Wizard

| Setup has finished instaling Monitor on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

<Back || Fnsh |

You need register first, then the interface will be available.
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15306445202

The can get the register code with the run the “Register” program in the easyScada folder.

| easyScada
i easyMonitor
ﬂ easyServer

“} Manual

! Register

<21 ScriptEdit
EA chowCommbData

i® Uninstall easyScada

| | wisit us

Input the User machine code.(This code is from the PC which need install the monitor

software), then click "Get” button, the user register code will be generated. The you need tell

this register code to the end-users.

s Register

Project name

Publisher 14

User machine code

User regizter code

IMnnitnr

=]

|na|:|~an1

|1395445292

Get
Register X
Machine code: 1396443252
Ragister cods; |3903 508084|
FKegister

e

Input “register code” and click the “Register” button.
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f easyExplorer m

Registration success!

Then the monitoring interface will be available.
. iScada

w easyExplorer

Ei' easyServer

¥ Manual
| ShowCommData

) Uninstall easyScada

|| visit us

roject Database Help

1.6.2 Edit menu

“Edit” menu consists of commands used to edit screen, text and drawing as well as some
auxiliary commands, including Undo, Redo, Cut, Copy, Paste , Delete, Select All, Properties...

Undo: Used to cancel the last operation. The shortcut key is Ctrl + Z.

Redo: Used to recover the last operation. The shortcut key is Ctrl + Shift + Z.

Cut: used to delete the object chosen and copy it to the paste buffer area. The shortcut key
is Ctrl + X.

Copy: Used to copy the object chosen to the paste buffer area. The shortcut key is Ctrl + C.
Paste: Used to copy the object in the paste buffer area to the current screen. The shortcut
key is Ctrl + V.

Delete: Used to delete a chosen object. The shortcut key is Ctrl + Del.
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[Edit] Variables Drawlib(l) Layout Database Vie

| Undo Ctrl+Z
| Cut Ctrl+X
g Copy Ctrl+C
4 Paste Ctrl+V
] Delete Del
fi Select all Ctrl+&
b Properties...

E, Set Background color for window

Set grid color for window

==

Set grid size for window

Select All: Used to select all the objects in the current screen of the current project. The
shortcut key is Ctrl + A.

Properties: to open the property dialog box of the object.

Set background color for window: to set the current window background color.

Set grid color for window: to set the grid color of current window.

Set grid size for window: to set the grid size of current window.

§ r ™kl
Grid size ﬁ
Width: [Em

Haight- [20

1.6.3 Variables menu

Vie

Variables | Drawlib(l) Layout

Variable

| Set alarm/event
|

All the variables can be managed int such menu.
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Index | Global/device |Scan£upload Froperty Source Warniable Name Default value
16 RS232: COM[3] Addi1] | Scan  Digital 1008 | RS232:COM[3]Addi1] 1008 a
17 R5232:COM[3].Add1] | Scan  Digital Q00T | RS232.COM[3]Add(1] Q00T a
18 RS232: COM[3] Add1] ' Scan Digital o0z R5232 COM[3add1] Qo02 ]
19 R5232:COM[3].Addi1] | Secan  Digital Qo03 | RS232.COM[3]Addi(1] Q003 a
20 RS 232:COM[2LAddl1] | Scan  Digital | G004 | RS232:.COM[21Add1] 0004 0
21 |RS232COMBLAdI(1]  Scan  Digtd 0005 RS232COM[SAdd(1L000S o
22 RS 232:COM[2LAddl1] | Scan Digital | Q00e RS232:C0M[3LAdd] 1] Q008 1]
23 RS5232:.COM[3LAddT] ' Sean  Digital F | START_F1 o
24 RS 232:COM[2LAddl1] | Scan  Digital F2 |RESET_F2 o
25 RS5232:COM([3]Add1] | Scan  Digital F3 (Q1_0K_F3 o
2B R5232:COM[3Laddl1] ' Scan Digital F4 O1_ERROR_F4 I
27 RE5232:COM([3]Add1] | Sean | Digital F& (N_Ok_F& o
28 R5232:COM[3LAddl1] |Scan | Digital FE |N_ERROR_FE o
23 |RS232COM[3Ldd(l]  Scan  Digtd  F7 I5_0K_F7 0
30 RS5232:COM[3]Add1] ' Scan Digital F8 I5_ERROR_F3 1]
31 R5232:COM[3].Addi1] | Secan  Digital F3 (G2_0k_F3 a
32 RS232: COM[3] Add1] Scan  Digital (F10 |G2_ERROR_F10 a
33 R5232:COM[3].Add1] | Scan  Digital F11 |12_0E_F11 a
34 RS232: COM[3] Add1] ' Scan Digital F12 |12_ERROR_F12 ]
Batch add Add Delete Clear Y S Cencel

(4

Batch add: All the variables can be added with one button click.
Add: One variable will be added with one button click.

Delete: Delete the selected variable.

Clear: delete all the listed variable

Alarm/Event Settings

Alarn | Event | Comn state

Condition Caplion
add

Edit

~Condition 1
Variabl [I1_OK_FS e Dalete
Logic [= = Value 1 ]

Logic between | -

Condition 2
Variabl | =
Logic | - Value

Logic between | -

~Conditien
Varish] |
Logie | = Value

Captior |11 ERRORI|
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1.6.4 Drawlib(L) menu

Layout VWiew Help
Add drawlib Ctrlth

Delete drawlib Cirl+D

Add 1ib element Cirl+I
f% Delete 11k element

n
Add drawlib: To create a window library.
Delete drawlib : To delete the existed window library.
Add lib element: Add the combined objects into the named draw library.
Delete lib element: To delete the existed objects from the draw library.
Usage example.
1. Select some objects in the window and click right mouse, then combine.

2. Click the menu Add drawlib and to input a new name. Click ok.
=

Input Drawlib name

Drawlib name: |indicator|

e E B R{ED

Click the “show/hide drawlib” button i and select the
library named with “indicators”.

Then you can click “"Add lib element”to add the combined objects into the library.
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Now you can use the combined objects in the library to put into the screen by double clicking
the left mouse. The menu “delete lib element” can be used to delete the objects in the library

1.6.5 Layout menu

View Help

&h  Left align
Right align

Ca x

S Top align

Eottom align

Malte zame zize

'!_!'|;|
Down
Ta fromt

To battom

v Show zrid

# Snap to gzrid
w Show marzin

v Snap to margzin

Settings

Left align: used to align the left boundaries of the chosen objects on the left.

Right align: used to align the right boundaries of the chosen objects on the right.

Top align: used to align the top boundaries of the chosen objects at the top.

Bottom align: used to align the bottom boundaries of the chosen objects at the bottom.
Make same size: used to set the same height and width for the graphs chosen.The minimum
left coordinate is taken as the baseline.

Up:used to move the chosen object one layer forward.

Down:used to move the chosen object one layer backward.

To front:used to align the top boundaries of the chosen objects at the top.

34



To bottom:used to align the bottom boundaries of the chosen objects at the bottom.

Show grid: To show the grid...

Snap to grid: Make the objects to snap to grid.

Show margin: To show the margin.

Snap to margin: Make the objects to snap to margin.

1.6.6 Database

it [ Database | View Help

ﬂ Historical data parse

[==]

RESET F2,Q01_OK_F3.Q
1_ERROF. F4Il OK_F35 E|
J1_ERROR_F6I5_OK_ =
F715_ERROR_F3.02 O

»

I¥ Stast Time
[2005% 7218 |
|16:13:36 e
¥ Offsat time

[ [Minute ;['
[ Record count |1m:cc

™ End Time
|20158 78278 ~|
|16:18:35 —

0K

{

e

Prass "CTRL", wou can select multiple variablas »

{* Digital " Analos
Varl RS232:COM[3
VarZ RS232:COM[3
Var3 RE5232:COM[3
Vard RE8232:COM[3
Var3 START F1
Var6 RESET_F2
Var7 Q1 OK F3
Var8 Q1_ERROR_F
RS232:COM[3:Addr[1] 1001 [1 OK F5
RS232:COM[3]:Addr[1] 1002 I1_ERROR_F&
RS232:COM[3]:Addr[1] 1003 IS_OK_F7
RS232:COM[3]:Addr[1] 1004 IS_ERROR_F8
RS232:COM[3L:Addr[1] 1005 Q2 OK_F2
R5232:COM[3]:Addr[1]_I006 Q2_ERROR_F1
RS232:COM[3:Addr[1] 1007 [2 OK_F11
RS232:COM[3]:Addr[1] 1008 I2_ERROR_F1.
RS232:COM[3]:Addr[1] Q001 I6_OK_F13
RS232:COM[3]:Addr[1]_Q002 I6_ERROR_F1:
] —TT— b
,h‘fh‘te: “"ﬁ.\

_:—'—'_'-'_'-F'—F

0K I Canesl

Value

o oo o o o o o o oo R oo o ol o

You can select one or several variables and to export the data with .csv format.

1.6.7 View menu

m Help

| w Toolbar

v Status Bar

v Workspace

Info Window

Graph Window
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Toolbar: Hide or show the Toolbar.

Status Bar: Hide or show the status bar.
Workspace: Hide or show the workspace.
Info Window: Hide or show the Info Window.

1.6.8 Help menu

s |

; About easylMonitor. .. I

Help: Version number and copyright statement of easyMonitor are shown in Figure 2-37.

About easyNonitor

easyMonitor Yersion 1.0

}Uﬂ Copyright (C) 2013

Figure 2-37

1.7 easyMonitor Toolbar

easyMonitor totally provides three lines of shortcut tool buttons, including tool commands
and editing commands. After getting familiar with these buttons, designers can find the
desired commands quickly without searching in the menu bar. Each button has a floating
prompt, which appears when you move the mouse to the button. easyMonitor totally provides
below tool buttons. When these buttons are grey, they are invalid under current operation
status. See Figure 2-39.

eorier- v
[] Project Edit Variables Drawlib{l) Layout Database View Help
DEdE RS ra|¢ ¢ O0DHEmEEST S| &
| -|_ Bazic lﬁ Bitmap].ml:urve].@ Heterl%l"ipel . :
S ErOBROOC®D AR EwEGD |

Figure 2-39: Tool bar

As shown in the figure above, the commands in the tool bar are corresponding to the
commands in the menus. The functions of the buttons are as follows:

Standard toolbar:
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1]

:Corresponding to “New” command, with the shortcut key of Ctrl + N, used to create a

new blank project.

']

L= :Corresponding to “"Open” command, with the shortcut key of Ctrl + O, used to open an
existing project file saved in Windows with an extension name of “.ezpj”.

= :Corresponding to “Save” command, with the shortcut key of Ctrl + S, used to save the
current screen configuration that has been changed, with the file name and directory being

the same as the original.

&

: Used to delete the object chosen and copy it to the paste buffer area. The shortcut key

is Ctrl + X.

:Used to copy the object chosen to the paste buffer area. The shortcut key is Ctrl + C.

:Paste,Used to copy the object in the paste buffer area to the current screen. The shortcut

key is Ctrl + V.

9 Undo

: Redo

% :Print button

> : Start monitor button

¥ : Corresponding to “Zoom in” command, used to zoom in the current screen by 1x. For
further zoom in, click this button again.

&

: Corresponding to “Zoom out” command, used to zoom out the current screen by 1x. For

further zoom out, click this button again.

:To make the selected objects to snap to the margin.

: To show or hide the margin.

O
- I: To make the selected objects to snap to the grids.
*1:To show or hide the grids.

(= : To make multiple draw, that means if such button was clicked down, you can put the a

lot of times of the same one object into the window with one clicking on a certain object.
Otherwise you can only put one object with one clicking on a certain object.

= :Corresponding to “Left align” command, used to align the left boundaries of the chosen
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objects on the left.

3o :Corresponding to “Right align” command, used to align the right boundaries of the

chosen objects on the right.

+0
+0

:Corresponding to “Top align” command, used to align the top boundaries of the chosen

objects at the top.

O+
O+

: Corresponding to “Bottom align” command, used to align the bottom boundaries of the

chosen objects at the bottom.

[% : Scroll arrow, used to change the palm shape under Translate command back to ordinary

mouse shape.

i} : To show or hide the draw library.

Draw toolbar:
Basic:

-|_B&5i'2 |'ﬁ Bitmapl Ealzurvel@ Meterlq‘él’ipe1
SAE A DLal B xE @D

-|_ : Corresponding to “Line” command, used to draw a horizontal or vertical straight line.

B : Corresponding to “Line” command, used to draw a straight line of any direction in the

current screen.

5 : Broken line, used to draw any shapes.

o : Corresponding to “Curve/Arc” command, used to draw a curve or arc in the current

screen.

C}: Polygon, used to draw a polygon in the current screen.

[Al : Corresponding to “Rectangle” command, used to draw a rectangle of any size in the

current screen. Also can be used to display Static text, or used to display the register value.
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. Round Rect, used to draw a round rectangle of any size in he current screen.

O, Corresponding to “Rounded rectangle” command, used to draw a rounded rectangle in
the current screen.

&, Cylinder, used to draw a cylinder in the current screen.

&

: Sector command, used to draw a sector in the current screen.

£, Trapezia, used to draw a trapezia in the current screen.

=, Arrow, used to draw an arrow in the current screen.

=l : Multi text, used to display the static text, or display the register value in a fixed format.
## . Data input, used to set register value(AF,AQ,REG), also can be used to display the
datas.

: Data display

G'f’:: Clock display

£ : History data table

Bitmap

‘|_Basi|: ﬁBitmap | Time
H Y ot @ DO

i : Table, used to draw a table.

qﬁ : Bitmap, used to be inserted into the bitmap file for displaying.
L§ : Rotate bitmap, used to be inserted in to the bitmap which can be controlled.

5 . Gif file’ used to create an animation control in the current screen to move the controls.

L : 3D circle, used to display the digital IO, flag status

=, Corresponding to “Bit button” command, used to set in the current screen a touch key

for bit operation of the connected device, including bit setting, resetting, inching and
alternation.

: Group box, used to draw group box.

39



Curve

‘|_ Basicl ﬁ Bitmap l Time E Curve
B2 4 B3 Il

Ex :Trend chart, used to create a trend chart control in the current screen to monitor the

value change trend of continuous addresses of the connected equipment.

EAl :History trend chart, not available now.

|-|—l :Data group display, used to create a data group display control in the current screen to

display several groups of data in the trend chart.

:Bar graph, used to insert a bar control in the current screen to show the change in the

values of the monitored address with height change or left-right movement of bars.

Meter

‘|_ Basic l ﬁ Bitmap l Timel Eﬁ Curve EA Meter l
EEr ¢« @1 % 08 & 4+oi

: Corresponding to “Meter” command, used to create in the current screen a meter to
monitor the change in the value of single address of the connected device.

B4 :Meter2, to create in the current screen a meter to monitor the change in the value of
signal address of the connected device.

u : Breaker shape
. : Switch shape
8 : Transfer shape

@i‘l; Fan shape

| | : button switch, used to set the digital flag and the output status.

; : Pump shape

= . slider shape

: Progress shape, used to display the variable value.

: Flow shape

40



Pipe

‘l_ Bazie | ﬁ Bitmap ] Time | E Curvwe | X Meter
=lrFS0O0[D0O0Ua0

% Fipe l

=
F
&

: Pipe, used to draw pipe shape.

: Connect pipe, used to draw connect pipe shape.
: Bend pipe, used to draw the bend pipe shape.

: Free pipe, used to draw the free pipe shape.

0 : Tank, used to draw tank shape.

<

:Elbow, used to draw elbow shape.

O : Rod, used to draw rod shape.

01 : Rect pipe, used to draw Rect pipe shape.

5 : Free trapezoid, used to draw free trapezoid shape.

£ 1 standard trapezoid, used to draw standard trapezoid shape.

. Ellipse pipe, used to draw ellipse pipe shape.

Chapter 2 System composition of easyMonitor

2.1 Connection structure

easyMonitor is the configuration editing software of

and the Devices.( ELC/EXM series CPU)

1.Communication by RS232/RS485 mode between PLC and easyMonitor, the sever software

is not required.

a1

esay SCADA. easyMonitor allows
designers to edit project configuration on PC and then directly start the monitor button. Then,
communication with PLC can be constructed through the serial cable or Ethernet/GPRS
connection. There are 3 ways can be applied to establish the connection between easyMonitor



easyMonitor Directly connection use R$232 cable or
RS485 module{RS232 to RS485 converter

needed on PC end)
!. . .

~an—--
MySQL
database

2. Communication by Ethernet mode between PLC and easyMonitor and the PLC works as

ELG/EXM series CPU

server, the server software also is not required.

easyMonitor GCommunication by Ethernet connection and the PLC works

as server. the server software is also not reauired.
- !

-
MySQL
database

ELC/EXM series CPU

Ethernet modem
would be set as
server mode

3. Communication by Ethernet/GPRS mode between easyMonitor and the PLC works as client,
the server software would be required.

easy server

EESVMnnimr !.

Client
= Static IP address/Domain name needed =

<o
MySQL
database

ELC/EXM series CPU

Ethernet modem would
be set client mode
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& easyNonitor — [I0 status monitoring] -
(L) Layout View Help

[is} = S vt 200wk 5]

| A Basic| W Bitnap | BB Tine | I3 Carve | B Meter % Eine | |
|[=lEF%0x80Uc0 |

Serial communication.ezpj 11 12 13 14 15 16 17 I8 111 112 113 114
E '1nds

ANALOG INPUT VALUE: k | COM STATUS:
AIl = @CPUAIL ; |

AI2 = @CPUAI2;
AI3 = @CPUAI3; - |
Al4 = @CPUAI4 ; e |

Q00O -9 90006

ol ioR o oFffo = @ G R E a3 a1
\

EasyMonitor interface showing as above

= easyServer — [ComDatal] |2
= E Vi Help

easyServer: ELCO3, @Address: 182.168.0.133 is running on port appiplc: 6365,5001 Connected:1, 1

SE‘"’E"!.------------------------------!. Scada

| bbbtk skl stk sk s |

P

Ll
E E 3 : i

EasyServer interface showing as above

2.2 Basic operations of easyMonitor

This chapter introduces operation of easyMonitor configuration software, including use of
mouse, shortcut keys and some terms.

2.2.1 Use of mouse and shortcut key of easyMonitor

When preparing configuration screens using mouse, the mouse is

as shown in Figure 2-41. right butten

. . . left button
Now we introduce common mouse operations and the functions of
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such operations in the software:

© Left click

The process of pressing down the left key and then releasing is

called “Left click” in this Manual. It can be used to select Figure 2-41
menu items, select object, select tool button, edit configuration

and confirm setting.

© Double click

The process of quickly and continuously clicking the left key twice is called “"Double click” in
this Manual. It can be used to set properties for placed objects, set properties of screen and
window, After such clicking a dialog will appear for operation.

© Right click

The process of pressing down the right key of mouse and then releasing is called “Right click”
in this Manual. You can open a right click drop-down menu by right clicking an object, or open
a right click menu by right clicking a blank space.

O Drag

The process of moving the mouse while pressing the left key is called “Drag” in this Manual.
It can be used to select several objects, move objects, or move pop-up editing windows.

2.2.2 Mouse shape

When using easyMonitor software, the shape of the mouse may change with the operation to
distinguish different operation types and provide convenience for users. Table 2-1 below
shows the allowable operations of different mouse shapes.

L‘\g Choosing object, and left clicking tool button.
1.Pasting.

e 9
2.Drawing a graph.

I Inputting text.

I Enlarging object vertically.

+— Enlarging object horizontally.

Py Enlarging object both vertically and
horizontally.

" Enlarging object both vertically and
horizontally.
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"I" 1.Move the object
2.Enlarging object both vertically and
horizontally.

Table 2-1: Different mouse shapes and corresponding meanings

2.2.3 Shortcut keys

Table 2-2 below lists common shortcut keys. Designers can use these keys to quicken the
configuration.

Ctrl + C Copy

Ctrl + V Paste

Ctrl + X Cut

Ctrl + left click Select several objects at the same time.

o T | Move the object chosen left, right, up and
s down.

Esc Cancel the command.

Del Delete

Chapter 3 Basic steps of creating a project with

easyMonitor
3.1 Creating a new project with easyMonitor

To create a new project, click the “Project->new” command in File menu or the
" Project->new” button in the tool bar, and then a pop-up dialog for new project creation will
appear. Select a directory for project saving, and choose a name for the project. Choose the
model of the touch screen corresponding to the project, click OK to complete the creation and
enter the communication port setting dialog. Click “Cancel” to quit the dialog.

3.1.1 New project dialog with easyMonitor

€ Project name: The name of the project to be created.
€ Path: Directory to save the new project file, C:\ in default.
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po: easylonitor — [Viewl]
GPnJec( Edit Variables Drawlib(L) Layout View Help -
i d = Bo2&(w||f 80 Dil | [ 2 2 l}{&}_
= Busic | 3iensp | B Tine | Fk covve | B mater | & Fips |
+/GrooooeobhakaB-

Test.ezpj

=03 Tindors
SystenStart
E 1

L] hdar (1]
5, RS232:CON (2] Addr [2]
(G, sz32 Con[3] : Addr [3]
5, RS232:CON 4] : Addr [4]
(Gl Rsz32 Con[5] : Addr 5]

([ Serint

3.1.2 Create new device

When you create new project, there are 5 default devices can be used directly, You can add
device, edit device or delete device by right click and select one operation.

You can click the “Device” and then right click.

SR Device 563

(s RSE32:COM[1]: Addr [1]
G RSE32:COM[2]: Addr [2]
s RSE32:COM[3]: Addr [3]

E‘ Add dewice hr [1 ]
B, RS232 . COM[2]: Addr [2]
(& R3232:COM[3]: Addr [3]

s RS232:COM[4]: Addr [4]

i i (s R3232:COM[4]: Addr [4]

& Rsz3z:COM[S]: Addr[S]

You can select one existed device, and click right mouse.
=] Device

Y COM[1]:Addr[1]

&l ES232: COM[2] - Addr [2] _— 2]

B B5232: COM3 ] Addr [3] g 131

(g BS232:COM[4]: Addr [4] S5 R3232:COM[4]: Addr [4]

: QﬁESZSE:EDM[E]:Addr[E] Bl BS23Z COM[S]: Addr [S]

=l ] Device
Edit dewice

f.

Click Edit device, then the below dialog box will be appear.
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Comm iData 1
1 R S— inszsz:cum[ﬂ:nda:[ll
2 —mwe | esca ety <
|
3 | | Model: . |FIC-120C-DA-R x|
i ;
W nse dewice

5  se |7 -

Comm type-

+ RSZ3? Port ]1

: [a600 -]

6 ||| ¢ psaas =

" Ethernet/GPRS/WIFI

{* IF addrees l

TL Tame l

0K | Cancel J

1.Name: The connection name edition, the default format is Com type:Port number: Address.
You can named the connection as your requirement.
2.Address: PLC address of ELC/EXM CPUs. Different connections must be different device

address.

You can change the CPU address by key pad Set..-> Set Adr -> Set M Adr

Also you can change the CPU address by the programming software(xlogicsoft for xlogic,
eSmsConfig for x-Messenger). Menus in software is Tools-> Transfer -> set PLC's address/Set
EXM address.

Frotoes] |Modbus-RTU |
3. Protocol: ‘R Modbu=-TCE Modbus RTU and Modbus TCP are the optional

communication protocol.

4. Model: The CPU model will be monitored or controlled.

All the ELC series xLogic and EXM series CPU can be monitored. But some CPU have no
Ethernet connectivity, so those CPU will cannot be monitored via Ethernet connection, but the

serial connection is supported.
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5.Ext: Extension selection

ixt. ||7 Ext. 2 ﬂ
[v Ext.1
W

Comm t

* RSeS [ Ext.3
[ Ext.4

[ pedar [ Ext.S

Select how many extensions will be used by tick up the option box

6.Comm type :

There are 3 com type available:

RS232 : serial connection between PC and CPU.

RS485 : RS232 to RS485 converter needed, PLC shall be connected to the RS485 network.
Note: RS232 and RS485 in fact are both serial connection, you can select any one if use serial
port to communicate with PLCs.

You need set the serial port number and the BPS for serial connection, the default baud rates
of PLC is 9600. If you change the baud rates to 19200 or other option, you need change the
baud rates for COM1 of PLC first.

Comm type

{+ RSZ32

Fort 2
; lozon. v
 RS485 s

" Ethernet/GPRS/MIFI

& |

e : |

Ethernet/GPRS/WIFI:
This option is only applied to the CPUs which supports the ethernet connectivity.

Lomm type
(" Rs232 Port B365
" RS485 e 2l

(¢ Ethernet/GPRS/WIFI

®IP addres | O -0 .0 . 0O

™ Domain mame |

MODE 1: easyMonitor directly connect to the Ethernet module(The Ethernet module must

work as server) without using the server software, here the IP address settings is the
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Ethernet module IP address, port is the local port in Ethernet module.

Gommunication by Ethernet connection and the PLC works
as server. the server software is also not reauired.

Client
I |

-
MySQL
database

easyMaonitor
ELC/EXM series CPU

Ethernet modem
would be set as
server mode

MODE 2: easyMonitor and devices(PLCs) are both connected to the server software. Now the
IP address settings is the IP of PC which installed server software, the port number also is

forward to the PC which installed the server software.

easy server

A !.

Client
= Static IP address/Domain name needed =

ﬂ TR
ko T T ——

MySQL
database

ELGC/EXM series CPU

Ethernet modem would
be set client mode

Domain name: This option is only for the EXM CPUs which supports the GPRS connection.
easyMonitor and the EXM are both can be connected to such domain name.(This domain

name need be forward to the PC which installed the server software).

3.1.3 Create the datas/variables/ for the devices

Click Edit device, then the below dialog box will be appear and then swith to the “"Data” page.
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Comm Data |
Indexr | Tepe CPLExt Address fount Friorsty i
or I o 0 B 0
ey ] i 0 i 0 i 4 i 0 Edit
o7 F D D 4 :-D .
i REG ] 0 16 1] . Delete

0K I Cancel

You can add new data, edit or delete the existed data by clicking the corresponding button.

omm Data

Add

Edit |
Delete |

— Drata type

" Input

 Cratput

(" Analng input

« Analog cutput

" Fleg
 dnaleg flaz
oM

AM

" Register

0K | Cancel




There are 9 kinds of data types:
Digital type includes : Input, Output, Flag, M;
Analog type includes: Analog input, Analog output, Analog flag, AM, Register

Address
|AIIIIIIIl vl
: You can select one as the start address.
Comint
16 =

: Enter into the count for the data, maximum 16 in one time.

If you want add one kind of data more than 16, you need add the data twice or more with
modify the start address.

For example, if you had added the flag as below figure shows, then the available flag would
be F1--F20 .

|:|:||-|-||-|-| D&t&
Index | Tvpe CPlEt Addresz Count Friorrty
] Add

o1 I 0 0 8 0

| il I il
a2 q 0 0 |4 0 Edit
a3 REG : 0 : 0 16 : 0
04 REG 0 Ik 16 0 Delate
a5 AT | 0 | a KL 0

| | — 5 |

f L (L (s ) &
67

After the data had been added for a certain devices then confirm with ok button, then you
need add them in to the variable library, so, the data/ variable would be available for the
display objects.

Click the menu Variables -> Variable
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|
Index | Global/device | Scan.-"upload| Froperty | Source | Wariable Mame | Drefault value | i
1 R5232:COM[3L:Add1] Scan Drigital a0 Warl 1] | i
2 R5232:.COM[3LAddi1] Scan Digital a0z |Mar2 a =l
3 RS232:.COM[3].Addi[1] Scan Digital 1003 Ward 1] 3
4 R5232:COM[3L:Add1] Scan Drigital 1004 Ward 1]
5 R5232:.COM[3]:Addi1] Scan Digital 1005 ‘arh 1] |
B RS232:COM[3].Addi[1] Scan Digital 1006 | Varg a |
7 R5232.COM[3L:Add1] Scan Digital a0y War? 1]
] R5232:.COM[3]:Addi1] Scan Drigital 100g R 1]
9 RS232:.COM[3].Addi[1] Scan Digital 1o R5232:COM[3L:addd 1] 10071 0
10 R5232:COM[3L:Add1] Scan Digital 1002 | R5232:.COM[3]Add1] 1002 a
11 R5232:.COM[3L:Addi1] Scan Digital 1003 RS5232:.COM[3}:4dd1] 1003 1]
12 RS232:.COM[3].Addi[1] Scan Digital 1004 R5232:COM[3:Addi1] 1004 0
13 R5232:COM[3LAdd1] Scan Digital 1005 RS5232:COM[3}Add11I1005 1]
14 R5232:COM[3LAdd1] Scan Digital 1006 | RS232:COM[3].Add1] 1006 a
15 RS 232:.COM[3].Addi[1] Scan Digital 1007 RS 232:COM[3:addi1] 1007 1]
16 R5232: COM[3L:Add1] Scan Drigital 1003 R5232:COM[3}:Add1]1008 1]
17 R5232:COM[3]:Add1] Scan Drigital Qoo RS5232:.COM[3}Add1]_ Q00 1]
18 RS232:.COM[3].Addi[1] Scan Digital ooz | R5232:COMI3Add1] Q002 a
19 R5232.COM[3L:Add1] Scan Drigital G003 R5232:COM[3}:Add[1]_3003 1] -
Batch add Add Delete Clear [1):4 | Cancel

Two kinds variable are available : digital/analog variable from device or Global.
You can add new data, edit or delete the existed data by clicking the corresponding button.

Click “Add” to add the variable, then one variable will be added, then you can change the
variable type and variable name.

Index | Global/device | Scana’upload| Property | Source |\r"aliab|e M ame | Default value | E
38 RS232:COM[3LAdd1] Scan Analog AM15 RS232.COM[3LADdI1]_AM15 0 |

39 RS232.COM[3LAdDd1] Scan Analog AM1E | R5Z32:COM[3Add 1] AM1E 0

100 RS232:COM[3Addr1] Scan Analog REGD RS232:COM[3}4dd[1] REGO 0

101 RS232:COM[3LAdd1] Scan | Analog REG1 RS232:COM[3LAdd1] REG1 0

102 RS232:.COM[3LAdd1] Scan Analog REG2 RS232.COM[3}Add[1]_ REG2 0

103 RS232.COM[3LAdDd1] Scan Analog REG3 | R5232:COM[3LAdd{ 1L REG3 0

104 RS232:COM[3LAddr1] Scan Analog REG# RS232.COM[3LAddi[1] REG4 0

105 RS232:COM[3LAdd1] Scan | Analog REGS RS232:.COM[3LAdDd(1]_ REGS 0

106 RS232.COM[3LAdDd1] Scan Analog REGE RS232.COM[3LAdDd(1]_ REGE 0

107 RS5232.COM[3LAdd1] Scan Analog REGY | R5232:COM[3LAdd{ 1] REGT 0

108 RS232:COM[3LAddr1] Scan Analog REGS RS232.COM[3LAddi[1] REGS 0

109 RS232:COM[3LAdd1] Scan | Analog REGS RS232:.COM[3LAdd[1]_ REGI 0

110 RS232.COM[3LAdDd1] Scan Analog REG10 RS5232.COM[3LADd[1]_ REGTO 0

111 RS5232.COM[3LAdd1] Scan Analog REG11 | R5232:COM[3}Add{ 1] REG11 0

112 RS232:COM[3LAdd1] Scan Analog REG12 RS5232.COM[3LAdd1] REG12 1] |
113 RS232:COM[3LAdd1] Scan | Analog REG13 RS5232.COM[3LAdd1]_ REG13 0 | |
114 RS232.COM[3LAdDd1] Scan Analog REG14 RS232.COM[3LADd1] REGT4 0 =
115 RS232:COM[3Addr1] Scan Analog REG15S RS5232:COM[3]:4dd1] REG15 0 ! !

[[116 " |Gobal Analog 0 = ‘

Eatch add l Telete ‘ Clear [1):4 Cancel

Double click each item to change what you need.
|16 |Giobal = Andog 0 |~

LIy 1 ~ 1 e I - -

116 | AS232 COM[3]AddI1]

R-~t+ak -A3 ] 4 A3 1

. o e g g e = - e

b el R oL :

J [ R | ne I Mamasd
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Generally, we need select "Scan” for each variable. Upload is only for the application the GPRS
upload function block of EXM series CPU. We will describe it in detail at chapter 5.

16 RS232.COM[3LAdHT] Scan [Digtal =] 1001 ' ' E
Digital

Fatrh =44 I L | I MNalcata I My I Farnnal I
Variable can be digital or analog type.

.- .- . . - - =

118 RS232 COM[3LAd]1] Scan Digital [ - |E|

oz
Batch addl Add | Delete | Clear|iggy |

1004
1005 x

[ »
%
3

116 RS 232 COM[3TAD1] Scan Drigital 1001 [SwATCH 1]

You can directly edit the variable name in the table.

3.2 Graph editing commands of easyMonitor

3.2.1 Combine and dispart of easyMonitor

“Combine” command is a group command, used to combine two or more graph objects in the
current screen to a whole graph object. The objects to be combined may be graphs drawn by
designers or users, or graphs from picture library of the system, or other controls such as
alarm control and trend chart. After combining the original properties of the graph elements
will not be kept. An combined object, graph or control is a whole image and can be saved as
library control for future use,helping to save much time of the users. “Dispart” command is
used to dispart a graph combined using “"Combine”command to the original elements. After
disparting the original properties of the elements can be recovered.

“Dispart” command is a reverse command of "Combine” command.

The combining steps are as follows:

@ First, choose the graph objects to be combined, then press “Combine” command by calling
the right click menu and choose combine command. Figure 4-6 shows the

contrast before and after combined.

Figure 4-6 shows the contrast before and after combined.
The disparting steps are as follows:
© Choose a graph object combined using combine command, and then choose dispart
command by calling the right click menu and choose Dispart command . Figure 4-7 shows the
contrast before and after disparting.
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Figure 4-7 shows the contrast before and after disparting.

3.2.2 Layout of easyMonitor

“Layout” command is a group command, used to adjust the display sequence of intersected

graph objects in the screen. Each graph in easyMonitor has a layer, and graph objects on
upper layer are always displayed on top of the objects on lower layer.
Thus, we can use this command to adjust layer level of graph objects. By default, objects
created later are on upper layer than those created earlier. There are four Layer commands
thatare “Up”, “Down”, “Tofront”,and “Tobottom” . To execute these commands, first
choose one or more graph objects in the current screen, and then choose corresponding
Layer commands in layout menu or by calling right click menu .

To front

This command is used to move the chosen object to the top layer of all the graph objects in
the current screen. Thus, the parts of other graphs intersected with this graph will be covered
by this graph. Figure 4-8 shows a contrast before and after such moving.

First choose an object in several graphs, and then choose Move to Top command in Layer
menu, or call the right click menu and choose To front command . See Figure 4-8 for a
comparison before and after combination.

Object before the forward Object moved forward after
Figure 4-8: Contrast before and after moving object forward

To bottom
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This command is used to move the chosen object to the bottom layer of all the graph objects
in the current screen. Thus, the part of this graph intersected with other graphs will be
covered by other graphs. Figure 4-9 shows a contrast before and after such moving:

First choose an object in several graphs, and then choose to Bottom command in layout menu,
or call the right click menu and choose to Bottom command . See Figure 4-9 for a comparison
before and after combination.

Object before To bottom Object moved To bottom

Figure 4-9: Contrast before and after moving object backward

Up

This command is used to move the chosen object to an upper layer over the graph object
intersected with it. Thus, the parts of other graphs intersected with this graph will be covered
by this graph. Figure 4-10 shows a contrast before and after such moving.

First choose an object in several graphs, and then choose Up command in layout menu, or call
the right click menu and choose Up command in the Layer option. See

Figure 4-10 for a comparison before and after combination.

Ohject moved forward a Execution of a forward again - Execution a layer of two times
Layer of former the forward

Figure 4-10: Contrast before and after moving object one layer forward

Down
This command is used to move the chosen object to a lower layer than the graph object

intersected with it. Thus, the part of this graph intersected with other graphs will be covered
by other graphs. Figure 4-11 shows a contrast before and after such moving.
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First choose an object in several graphs, and then choose Down command in Layout menu, or
call the right click menu and choose Down command. See Figure 4-11 for a comparison
before and after combination.

Object moved a layer of The object of a back again The object of a back twice
former

Figure 4-11: Contrast before and after moving object one layer backward

Left align

“Left Align” command allows designers to align several graph objects chosen basing on the

left boundaries of the graphs. To do this, first select several graph objects (2 or more), and

O+
then click Left Align command in layout menu, or click Left Align button 6+ in the tool

buttons. Then the graphs will move left to align basing on the left boundaries. See Figure 4-12
for a contrast before and after left align.

@ @

Left align before Right align after
Figure 4-12: Contrast before and after left align
Right align

“Right Align” command allows designers to align several graph objects chosen basing on the

right boundaries of the graphs. To do this, first select several graph objects (2 or more), and
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then click Right Align command in layout menu, or click Right Align button % in the tool

buttons. Then the graphs will move right to align basing on the right boundaries. See Figure

4-13 for a contrast before and after right align.

Right align before Right align after

Figure 4-13: Contrast before and after right align

Top Align
Top Align” command allows designers to align several graph objects chosen basing on the top
boundaries of the graphs. To this, first select several graph objects (2 or more), and then click

Top Align command in layout menu, or click Top Align button *T in the tool buttons. Then

the graphs will move upward to align basing on the top boundaries. See Figure 4-14 for a

contrast before and after top align.

Top align before Top align after
Figure 4-14: Contrast before and after right align

Bottom Align
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“Bottom Align” command allows designers to align several graph objects chosen basing on
the bottom boundaries of the graphs. To do this, first select several graph objects (2 or more),

and then click Bottom Align command in layout menu, or click Bottom Align button 55 inthe
tool buttons. Then the graphs will move downward to align basing on the bottom boundaries.

See Figure 4-15 for a contrast before and after bottom align.

Bottom align before Bottom align after

Figure 4-15 for a contrast before and after bottom align

Make same size

“Make same size” command allows designers to set the same height and width for several
graph objects chosen basing on the height and width of the highest graph object (considering
the top boundaries), with the top left coordinates of the graph objects being fixed. To do this,
first select several graph objects (2 or more), and then click Make same size in layout menu.
See Figure 4-16 for a contrast before and after such processing.

Make same size before Make same size after

Figure 4-16: Contrast before and after “Make same size”

3.3 Drawing basic graphs with easyMonitor

This chapter introduces in detail the operations of drawing basic graphs with easyMonitor.
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3.3.1 Line of easyMonitor

i :can be used to draw the straight line on any direction in the window.

Click Line 5 command button in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now

you can draw lines in the screen by clicking the mouse.

> After completing the above steps, the line has default settings in line type, line width,
line color. You can modify these settings basing on actual needs. To do this, move the
mouse onto the line and double click, or click Properties button in the Edit menu after
choosing the line. At this moment, a property dialog as shown in Figure 4-17 will appear.

Property [LINE] §|

Color iDynamic I

|

—Graph

0K l Cancel I Help | |

Figure 4-17: Line property dialog

The available settings include the Line color, line type, line width, other settings is not

available for the line/Tline object.

You may adjust the properties of the line using the pull-down and fine tuning button.

easyMonitor provides 5 line types,9 line widths.
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Line
Type:

fidth:

FS_DASHDOTDOT

o
PR |Es L

There are 5 types line available :
PS_SOLID:

PS_DASH:
PS_DOT:
PS_DASHDOT: *

PS_DASHDOTDOT: *

3.3.2 Rectangle of easyMonitor

Click Rectangle command button [A] in the tool buttons, and then move the
mouse to the picture editing window. At this moment the mouse shape will become a cross,

and now you can draw rectangle in the window.

> To change the size of the rectangle, first choose it and move the mouse to any of the 8
green square dots on the frame of the rectangle. When the mouse becomes < , press
down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the rectangle has been adjusted.

»  After completing the above steps, the rectangle has default settings in transparency,
background color, fill type, fill color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the rectangle and double click, or click
Properties in the edit menu after choosing the rectangle. At this moment, a property
dialog as shown in Figure 4-18 will appear.
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Property[Rect]

Title Color |Dymamic|
~Graph- < ~Color

Forsground
Backezround

Fill type:

Fill color

~Frame line

Type: IPS_DASH vl
#idth: il - ]

~Font

] Connect
Select Font
0 | Canead | T J

=

Figure 4-18 Rectangle properties dialog

The available settings include the Foreground (is for the font color), background,Fill
type,Fill color and the size , other settings are not available for the “Rectangle” object.

Variahle select
Variable select

S @ vt © halog

Titte |cf Mg Description

Vari abl.

— s | = — € |

=T

Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.
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Property[Rect] @

Title Color |Dymaniz|

Color 1 Font

Foreground Select Font

B

C{JimecJ

Type: [PS_SOLID = |
#idth: |! ¥
~Size

frne #idth (192

¥ Displey Height |5

You can input a static text or to show the register value with such text object.
A. As a static text display.

Property[Text]

Title ]Color ]D}’namic]

Yariable

—Alavrm-

1.Input the static text in the variable box, and do not tick up the “as value” option.

Fropertyllext A

Title Color |Dymamic|

Color 1 Font

:
-onne

Line -
-Line

| Type:  [F350LI0  »
| #iden: ! z

Fill type: ]‘—_]7 Z

Fill color

~Size
idth [250

_rDisplay Height 40

1) I Cancel Help
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2. You can do not display the frame of the text without ticking up the “Display” option in
Frame, and set the color with select the color in foreground, and set the font with click the

“Select font” button.

3.3.3 Rounded rectangle of easyMonitor

Click Rounded Rectangle command button ' in the tool buttons, and then move the mouse
to the picture editing window. At this moment the mouse shape will become a cross, and now

you can draw a rounded rectangle in the screen by clicking the mouse.

> To change the size of the rectangle, first choose it and move the mouse to any of the 8
green square dots on the frame of the rectangle. When the mouse becomes < , press
down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the rectangle has been adjusted.

> After completing the above steps, the rounded rectangle has default settings in
transparency, background color, fill type, fill color and the size. You can modify these
settings basing on actual needs. To do this, move the mouse onto the rectangle and
double click, or click Properties button in the tool bar after choosing the rectangle. At this

ment, a property dialog similar to that in rectangle drawing will appear. See Figure 4-19:

Property[Round Rect]

Title Color |Dynamic|
~Graph LCalar

Foreground

Background

Fill type:

Fill color

~Frame line

Type: ]Ps_snun = j

Width: il -
~Font - -
Connect
Select Font
0K | Cancal ] Help |

Figure 4-19 Rounded rectangle properties dialog
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The available settings include the Foreground (is for the font color),background,Fill type
and the size , other settings are not available for the * Rounded Rectangle” object.

Yariable select

Fropexty Bop ey  hnalog " Digital & Analog
Titde o [Varianta | Desevip Tied [Varishl Deseription
flagl |
Variabl{ | ag2 . .
flacd ]
Marm
I =
— & | & < | &
nay | Help
Canzel i oK Concel |

Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.

Title Color |Dymanic

E | Color Font
&
Conne
Type: [FSSOLID  +
Fill e = o -
Wideh [t &l
Size
Frame . 200
Fidth
[ Height |50

The Displaying font also can be changed in the color option with the button “Select Font”.
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After the communication is established between easyMonitor and PLC, the digital status will

display 0/1(0= off, 1=0n), the analog values of the selected register also will display the real
time values in the PLC

3.3.4 Ellipse/Circle of easyMonitor

Click Ellipse/Circle command button > in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can draw ellipse/circle in the window.

» To change the size of the ellipse/circle, first choose it and move the mouse to any of the
8 green square dots on the frame of the ellipse/circle. When the mouse becomes ‘$',
press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the ellipse/circle has been
adjusted.

»  After completing the above steps, the ellipse/circle has default settings in transparency,
background color, fill type, fill color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the ellipse/circle and double click, or click
Properties in the Edit menu after choosing the ellipse/circle. At this moment, a property
dialog similar to that in rectangle drawing will appear.See Figure 4-20.
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Property [ELLIPSE]

Title Color |Dymamic|

i Graph-

— rCoalar

Foreground

Backsround

Fill type:

Fill color

. =
Color

L1
L1
—

Type: ]PS_SDLID - i
Width: 1 - i
—Font —

Select Font Connect |

= ]

Canecel 1

Help

Figure 4-20 Ellipse/Circle properties dialog

The available settings include the Foreground (is for the font color), background,Fill

type,Fill color and the size , other settings are not available for the “Ellipse/Circle” object.

Variable select X
* Digital " Analog
[Varisble [ Deseription
flagl
flag?
flag
Title |Celer | Dymanis
Variable
[V az value
~Alarn
&0 "
I~ Marm .
A
o
S
< 8
ox Taneed Kelp |
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Property [ELLIPSE]
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Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.

Title Color |Dymanic|

Color Font
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The Displaying font also can be changed in the color option with the button “Select Font”.
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After the communication is established between easyMonitor and PLC, the digital status will
display 0/1(0= off, 1=0n), the analog values of the selected register also will display the real
time values in the PLC

3.3.5 Cylinder of easyMonitor

Click Cylinder command button = in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can draw cylinder in the window.

» To change the size of the Cylinder, first choose it and move the mouse to any of the 8
green square dots on the frame of the Cylinder. When the mouse becomes '%’, press
down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the Cylinder has been adjusted.

»  After completing the above steps, the Cylinder has default settings in transparency,
Internal ellipse share, background color, fill type, fill color and the size. You can modify
these settings basing on actual needs. To do this, move the mouse onto the Cylinder
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and double click, or click Properties in the Edit menu after choosing the Cylinder . At this

moment, a property dialog similar to that in rectangle drawing will appear.See Figure
4-21.

Property [CYLIRDEE]

Title Color |Dymanic |
~Graph

—LCalor

Text

big -
&

Small

~Font

Select Font ORTEEL

termal ellipse share: (0.3

Hote: if the mumber iz <=0 or
7=1, then the =mall ellipse
will don’ t display

1] 4 Cancal Help i

Fs

Figure 4-21 Cylinder properties dialog’

Property [CYLINDER] Variable select
Title |Property| Color | Dymamic|
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Variable select X |

Title
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Variable | Deseription
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IS
=

|

o

il |
Help
o

Variable status/values can be displayed in such object if you select a variable(digital or analog
variable) in.
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Property [CYLIRDER]

Titls |Froperty Coler ]Dymmid

Color Font

/—ligr’e‘gm. -\Select Font

Background

FL type: [ ] Trzer [0 ]
— maw 1 =]

Size
piam B0

¥ Displ Height [184

‘onne

Help

The Displaying font also can be changed in the color option with the button “Select Font”.

After the communication is established between easyMonitor and PLC, the digital status will

display 0/1(0= off, 1=0n), the analog values of the selected register also will display the real

time values in the PLC

3.3.6 Pie chart of easyMonitor

Click Pie Chart command button L3 in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a pie chart in the screen by clicking the mouse. See Figure 4-22:

Figure 4-22: Draw a pie
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> Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become . Then, you can change the span of the sector by moving
the mouse along an arc course.

»  After completing the above steps, the Pie Chart has default settings in background color,
fill type, fill color and the size. You can modify these settings basing on actual needs. To
do this, move the mouse onto the Fan Chart and double click, or click Properties in the
Edit menu after choosing the pie chart. At this moment, a property dialog similar to that
in rectangle drawing will appear.

Property[PIE] 7'

Color 1 Dynamic 1

~Graph - Color

Background

Fill tppe: | ~

Frame line-

Colar

Type:

idth 1 - 1
Start angle ]D
i el cy o T ] 120]
OF Cancel Help
A

3.3.7 Trapezia chart of easyMonitor

Click Trapezia Chart command button <= in the tool buttons, and then move the mouse to
the picture editing window. At this moment the mouse shape will become a cross, and now
you can draw a Trapezia chart in the screen by clicking the mouse. See Figure 4-23:

> Move the mouse to any of the green dots in the rectangle, and at this moment the

mouse shape will become . Then, you can change the span of the sector by moving
the mouse to an appropriate position.



»  After completing the above steps, the Trapezia Chart has default settings in background
color, fill type, fill color and the size. You can modify these settings basing on actual
needs. To do this, move the mouse onto the Trapezia Chart and double click, or click
Properties in the Edit menu after choosing the Trapezia chart. At this moment, a property
dialog similar to that in rectangle drawing will appear.

Property[Trapezial

E3

Calor ; Dynamic ]

—Graph ~Color

Fill type: I_ :'l |
~Frame line ———
Type: IPS_SDLI]J vl
Width: =]
~Direct

" Right
" Left
i Up

¢ Down

0K | Cancel Help !

3.3.8 Arrow of easyMonitor

Click Arrow Chart command button [= in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you

can draw a Arrow in the screen by clicking the mouse. See Figure 4-24:

Property |1."ariablel Color l Dynamic I

Figure 4-24 Arrow direction can be set in the property dialog box



> Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become . Then, you can change the arrow by moving the mouse to
an appropriate position.

»  After completing the above steps, the arrow has default settings in background color, fill
type, fill color and the size. You can modify these settings basing on actual needs. To do
this, move the mouse onto the arrow and double click, or click Properties in the Edit
menu after choosing the arrow. At this moment, a property dialog similar to that in
rectangle drawing will appear.

Property [ARROY]

Color I Dymami o I

—Graph —LColar

Backeround

Fill type:
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Type:

Width:
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3.3.9 Multiple Text graphs of easyMonitor

Click Multiple Text command button E] in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can draw a text chart in the screen by clicking the mouse.

mutt:?
1. @I
2. @02 B
3. A1
BE EH H

You can edit the static text or insert the register value with the format “@register name” .
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Property [TEET]

Property IColor I Dynamicl

Hote:

1.F1= @flagl

2 REGD= @Analagl REGO
3. F2= @flag?

Angle iD ¥ Transparent

(1):4 I Cancel | Help |

Property [TEXT]

Froperty Color IDynamic!

—Graph —Calor

Background

Ii vl

Fill type:

Fill color

~Font

Connecs
Angle I':I ¥ Transparent

0K | Caneel | Help |

The color can be changed with the foreground color, and “select font” to change the text

font.

Note:

1.F1= @flagl

2.REGO= @Analogl_REGO
3.F2= @flag2

After the communication is established, then the register value will displayed followed the

symbol *@".

73



MNote:

1.F1=1
2.REGO= 56
3.F2=1

3.3.10 Data input of easyMonitor

Click data input command button ## in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you

can draw a data input object in the screen by clicking the mouse.
rropertyllataset]

Action il:.:-l-:ur i D}-namicl

—hction 1

¥ Click down Set

[ Es Tup

Action define

[ Monse
Caption I
Action type :'_l
Variahle souros HET:PORT[65365]:4ddr[1] _:i
el Sl =l
Handle wahie 5 Ficed I'—
{7 State fmrarsion

O I Cancel

Click the “Set” button in the property dialog box, then select one variable from the database,

then confirm with ok.
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Property [DataSet] x

heotion Coler |D3mamicl

—iraph ~Color

~Font

Connec

0K | Cancel | Help |

The number color and Font can be set in the color option, then confirm with “ok”.
Under the monitoring mode, you only need to click the area of the data input object, then the
below dialog box would be pop out. Input the data required, and confirm with ok button.

—_—Te AT e

Then the value will be set to the device(CPU).
Only the AF, AQ, and REG value can be set with such object, and please note if you want to set

the AF,AQ value, please do not connect the input leg of the AF,AQ block to other blocks in your
PLC program.
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As above figure showing, AF1--AF4 can not be set value, but the AF5--AF7 value can be set by

such data input object.

3.3.11 Table of easyMonitor

Click Line arrow command button i in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you

can draw a Line arrow in the screen by clicking the mouse.

> Move the mouse to any of the green dots in the rectangle, and at this moment the
mouse shape will become & Then, you can change the table size by moving the
mouse to an appropriate position.

>  After completing the above steps, the table has default settings in the row count ,
columns count , line color, line width and the display size. You can modify these settings
basing on actual needs. To do this, move the mouse onto the table and double click, or
click Properties in the Edit menu after choosing the table. At this moment, a property

dialog similar to that in rectangle drawing will appear.

Rows count and columns count can be set in the property dialog box.
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Froperty lCnlnr ] Dynamic]

Bow count 3
Col count 4

Froperty Color lDynamic]

Color Font

Background

Connect

Heedle
Fill twpe:
Fill color
Frame
w3

0K | Cancel Help

The line of table can be set color width, and the table size also can be set with a fixed value.

3.3.12 Bitmap of easyMonitor

Click bitmap command button 'ﬁ in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you

can put a bitmap in the screen by clicking the mouse.
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»  You can modify the basing on actual needs. To do this, move the mouse onto the bitmap
and double click, or click Properties in the Edit menu after choosing the bitmap. At this
moment, a property dialog similar to that in rectangle drawing will appear.

[Property [BITHAP] @

Froperty |Varisble | Coler | Dymamic |

[~ Transparent

|start bmp

Image file:

[ Dynamic image

Condition ‘

Image file: | R

Cancel wp |
Click the button(marked with red circle in above figure) to insert a new bitmap.
EYin)

Note: The bitmap must be imported from the “"Bitmap” file in the boot folder of easyMonitor.,
so you need copy your own bitmap into such file first.

»  After the new bitmap imported in, you can move the mouse to any of the green dots in

the rectangle, and at this moment the mouse shape will become + Then, you can
change the bitmap size by moving the mouse to an appropriate position.
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Property [BITHAP]

Property ]‘i’ariable ] Color ] Dynamic]

I Transparent

¥ Stretch image

Image file: 1start. bmp i
v Dynamic image

Condition:

Image file: 1farrow. bnp G

flagl==1

k| cancal | Help

You can also select the dynamic image, when the condition (for example flagl ==1), then the
“farrow.bmp” will display.

Note: 1.. flagl is a digital register in the variable database.

2. You do not need select any register in the variable option.

3.3.13 Rotate Bitmap of easyMonitor

Click rotate bitmap command button ng in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a rotate bitmap in the screen by clicking the mouse.

»  You can modify the basing on actual needs. To do this, move the mouse onto the rotate
bitmap and double click, or click Properties in the Edit menu after choosing the rotate

bitmap. At this moment, a property dialog similar to that in rectangle drawing will
appear.
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Property[Bitmapl ®

Property | Variable | Color | Dymamic |

Bngle JU—
5t s
Inage file: plc_1 brp
il a nage

Condition:
Image file:

Click the button(marked with red circle in above figure) to insert a new bitmap.

EYin)

Note: The bitmap must be imported from the “"Bitmap” file in the boot folder of easyMonitor.,

so you need copy your own bitmap into such file first.

»  After the new Rotate bitmap imported in, you can move the mouse to any of the green

dots in the rectangle, and at this moment the mouse shape will become @ Then, you
can change the Rotate bitmap size by moving the mouse to an appropriate position.

(]

Property [Bitmapl] |

Proparty |Varisble | Color | Dymanic |

¥ Transparent Mask Colour: l:l

Kele 3
-

Image file: [ple_t.bne

[T Ty §

Condition: |

Image file: I _I
" l roen | Halm

You can rotate the bitmap with set the angle in the red circled region in the property dialog
box.

3.3.14 gif picture of easyMonitor

Click gif picture command button S in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you

can put a gif picture in the screen by clicking the mouse.
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» You can modify the basing on actual needs. To do this, move the mouse onto the gif
picture and double click, or click Properties in the Edit menu after choosing the gif picture.
At this moment, a property dialog similar to that in rectangle drawing will appear.

Property [GIF] E]

Froperty ]".I’ariable ] Dymamic i

[T Tranzpavent

[T Stretch image

Image fila: lli‘ﬂ' gif *E

[T Dyuanic image

Condition: I

Imagze file: ]

0K ] Bt ] Hlp )

Click the button(marked with red circle in above figure) to insert a new gif picture.

[ & R

Note: The gif picture must be imported from the “Bitmap” file in the boot folder of easyMonitor,

so you need copy your own gif picture into such file first.

»  After the new gif picture imported in, you can move the mouse to any of the green dots

in the rectangle, and at this moment the mouse shape will become @ Then, you can
change the gif picture size by moving the mouse to an appropriate position.

Click the “Variable” option to select a digital variable for controlling this gif picture
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Yariable select

Property Yariable ]DYM'"H * Digital i
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If the variable is not equal to 0(both digital and analog variable), then the gif will be played
with an animation

3.3.15 3D circle of easyMonitor

Click 3D circle command button # in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can put a 3D circle in the screen by clicking the mouse.

» You can modify the basing on actual needs. To do this, move the mouse onto the 3D
circle and double click, or click Properties in the Edit menu after choosing the 3D circle
picture. At this moment, a property dialog similar to that in rectangle drawing will
appear.

»  After the 3D circle put in, you can move the mouse to any of the green dots in the

rectangle, and at this moment the mouse shape will become . Then, you can change
the 3D circle size by moving the mouse to an appropriate position.
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Select a digital variable for this 3D circle. Then set the ON color and OFF color for it in the
Color option.

roperty[3DCircle] _'

Variable Color i]]ynamic!

~Color . Font
arco [
OFF Color 3) [

Size

wian B0
Height 372

e I Canral 1 Haln

ON color and OFF color can be set by click the color area.

After the communication is established successfully, the corresponding color will be
displayed based on the digital register status.
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3.3.16 Button object of easyMonitor

Click button command button [ in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can put a button object in the screen by clicking the mouse.

»  You can modify the basing on actual needs. To do this, move the mouse onto the button
object and double click, or click Properties in the Edit menu after choosing the button
object. At this moment, a property dialog similar to that in rectangle drawing will appear.

Property[Buttonl

Title ]Actinn] Color ]D}Tt&m‘:]

Yariable @ 0

¥ as walue

[ Click down when walue=1

Alarm

You can input a static text on the center of the button object. (Do not tick up the “as
value” option). Or you also can select a variable with ticking up the “as value” option, then the
digital status will be display on the button.

Property[Buttonl

Title lhction] Color ]D}"namir_'

=]
Yariable
W as walue
Alarm-
a - T T eI AT T :

The button color can be changed in the Background; the text color can be changed in the
Foreground, and the text font also can be changed with clicking the “Select Font”.
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Property[Button] @
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»  After the button put in the window, you can move the mouse to any of the green dots in

the rectangle, and at this moment the mouse shape will become + Then, you can
change the button size by moving the mouse to an appropriate position.

3.3.17 Databox of easyMonitor

Click Databox command button in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can put a databox object in the screen by clicking the mouse.

» To change the size of the databox, first choose it and move the mouse to any of the 8
green square dots on the frame of the Cylinder. When the mouse becomes ‘$’, press
down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the Cylinder has been adjusted.

»  After completing the above steps, the databox has default settings foreground color(text
color), background color and the size. You can modify these settings basing on actual
needs. To do this, move the mouse onto the Databox and double click, or click Properties
in the Edit menu after choosing the database . At this moment, a property dialog similar
to that in rectangle drawing will appear.
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Property[Databox]
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Display decimal numbers can be set in the property dialog box.
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The variable can be selected from the variable library in variable option
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Property[Databox]
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The Size, background color, text color(foreground) and the text font can be changed in the

color option of the property box.

3.3.18 Date and time of easyMonitor

Click Date and time command button @ in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a Date and time object in the screen by clicking the mouse.

» To change the size of the Date and time object , first choose it and move the mouse to
any of the 8 green square dots on the frame of the Date and time object. When the
mouse becomes ‘$', press down the left key of the mouse and drag the mouse to an
appropriate position. Then release the left key of the mouse. So far the size of the Date
and time object has been adjusted.

»  After completing the above steps, the Date and time object has default settings
foreground color(text color), background color and the size. You can modify these
settings basing on actual needs. To do this, move the mouse onto the Date and time
object and double click, or click Properties in the Edit menu after choosing the data and
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time object . At this moment, a property dialog similar to that in rectangle drawing will

appear.

Property[Time]

[ 5

Froperty lVariableI Color I D}'namici

" Type 1 2013-11
* Type 2 2013-11-29
" Type 3 2013-11-29 15:45:00

5013-11-29
C Type 4 1g:45:00

There are 4 types date and time display format.

Property[Timel |E|
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0K | Cancel | Help !
A

The background color, foreground color(text color) and the text font can be changed in

the dialog box as above figure showing.
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3.3.19 Report table of easyMonitor

Click report command button | in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a report object in the screen by clicking the mouse.

Coll Col2 Col3 Colh Col5 Coléb Col? Col8
BHour HHEE hunn S hung HHHEE hung HHHEE W
1Hour HHE nunn HHHE hun HHHE hunn T W
2Hour HHHE Lt HHHEE i HHHE Hunn HHHE i
3Hour JHHEE Hungn HHHEE Hungn JHHEE HERR HHHEE i
4Hour HHEE L HHEE L i L I HE
SHour HHHE hunn HHHEE Hunn HHHEE i HHHEE LLii
6Hour JHHEE Hunn JHHEE HEnn JHHEE HEnn HHHEE W
7Hour HHEE HERy HHEE HuR S HERE HHEE HH
8Hour i L i L i Liiid HHEE HHE
2Hour THHEE L HHHE Hnnn HHHEE L HHHEE i
18Hour HHHEE Hunn JHHEE Hunn HHHEE hungn HHHEE W
11Hour T Lt T L] i Lidid i i
12Hour HHHEE hung HHHEE hunn S hunn i i
13Hour JHHEE R HHHEE i HHHEE Hunn HHHEE Wi
14Hour i i i Lisi i List T i
15Hour HHHEE nunn i nunn i hung T HE
16Hour S hunn T nung S hung S HE
17Hour JHHEE Hunn HHHEE Hunn JHHEE HERn JHHEE Wi
18Hour THHEE L T Hunn HHHE Hunn HHHET i
19Hour S hunn S nunn HHHEE hung S HHE
2BHour HHHEE wunn HHHE Hunn HHHEE HunE HHHEE WHH
21Hour HHHEE Hunn HHHE Hhunn HHHE hunn HHHET Lii
22Hour HHEE hunn S hung HHHEE hung HHHEE W
23Hour HHHEE Hunn JHHEE Hunn HHHEE Hunn JHHE W

» To change the size of the report table object , first choose it and move the mouse to any
of the 8 green square dots on the frame of the report object. When the mouse
becomes ‘$', press down the left key of the mouse and drag the mouse to an appropriate
position. Then release the left key of the mouse. So far the size of the report object has
been adjusted.

»  After completing the above steps, the report object has default settings foreground

color(text color), background color, the size and the set the variable settings. You can
modify these settings basing on actual needs.
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» To do this, move the mouse onto the report object and double click, or click Properties in
the Edit menu after choosing the report object . At this moment, a property dialog similar
to that in rectangle drawing will appear.

Property[Report] 3

"?foperf&y‘ﬂa'ta;. I‘]‘io‘l‘nr I }Jynamiic-f'

-~ Type-
(i altime data saved to .Ai.a'i.;b,asa -
(.:' Baxly' report "Eo’rms
" Wonthly report forms

At e

[V Show defarlt row title

'TI Cancel I ! Help I
In the “Property”item, there are three options can be select for the report table.

A. Realtime data saved to database
If such option was selected, then the report table will display latest cycle data in realtime.

B. Daily report forms
If such option was selected, then the report table will display latest 24 hours data per hour.

C. Monthly report forms
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If such option was selected, then the report table will display latest month data per day.
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Variable selection and caption edition can be done in the Data option of the property box.
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In color option, you can set the text color, background color, frame line width, type and color,
and the text font.

3.2.20 Trend chart of easyMonitor

=

picture editing window. At this moment the mouse shape will become a cross, and now you

Click trend chart command button in the tool buttons, and then move the mouse to the

can put a Trend chart in the screen by clicking the mouse.

= @ m}
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Overview of trend chart:

Displaying continuous values of variables on a dynamic and continuous basis.

Reference curves for multiple data can be drawn. Time will be used as the horizontal axis and
value will be used as the vertical axis to visualize the change trend of the value in a period.
3 polygonal lines can be displayed at most (line chart).
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Property[Realtime Curwel
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Curwve 3 ‘Analogl_REGU Select

Curwe colour

Curve | colour - Curwve 2 colour
Curve 3 colour -

JiE WHHH

Seale

Upper limit 200 Lower limit
#idth time

[ Show flaz

o | Comcel | Help

e

Related variable: you can select the variable for the Curvel, Curve2, Curve3.
Curve colour: you can set the colors for the curvel, curve2,curve3 separately.
Scale: You can set the Upper limit and the lower limit of the Y axis.

Show flag: Show or Hide the name of the Curves.

Property[Realtime Curwve] ﬁ
Property Coler lDy‘namic]
~Color 1T Font
oot [ soocrn
Connect
Type: FS_SOLID -
S & =
Width: |! i
T Size
Freus fidth 12
Ll Height |248

Foreground : Used to set the text color.

Background: To set the background color of the trend chart.
Select Font: To set the text Font.

Size: To set the size of the trend chart.
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3.2.21 History trend chart of easyMonitor

Click History trend chart command button B2 in the tool buttons, and then move the
mouse to the picture editing window. At this moment the mouse shape will become a cross,

and now you can put a history Trend chart in the screen by clicking the mouse.

3.2.22 Bar of easyMonitor

Click bar chart command button ll'l in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you
can put a bar chart in the screen by clicking the mouse.
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inalogl EER0 Analogl_KEGD inalogl_RER0

» To change the size of the bar object , first choose it and move the mouse to any of the 8
green square dots on the frame of the bar object. When the mouse becomes '%’, press
down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the bar object has been adjusted.

»  After completing the above steps, the bar object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the bar object and double click, or click
Properties in the Edit menu after choosing the bar object . At this moment, a property
dialog similar to that in rectangle drawing will appear.

Property [BAR]

Property 1Direct ] Color ] ]Jynamic]
Felated wariable

Bar 1

Selectl
Bar 2 |ﬁmalogl_R.EGO Salent
Bar 3 inalogl KEGD Select

Bar colour

Scale i
Upper limit 200 Lower limit 10
Width time
o
0 | Cameal | Help

Related variable: you can select the variable for the Barl, Bar2, Bar3.
Bar colour: you can set the colors for the barl, bar2,bar3 separately.
Scale: You can set the Upper limit and the lower limit of the Y axis.
Show flag: Show or Hide the name of the Bars.
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3.2.23 Single Bar of easyMonitor

Click single bar chart command button in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a single bar chart in the screen by clicking the mouse.

o

»  To change the size of the single bar object, first choose it and move the mouse to any of
the 8 green square dots on the frame of the single bar object. When the mouse
becomes ‘$', press down the left key of the mouse and drag the mouse to an appropriate
position. Then release the left key of the mouse. So far the size of the single bar object
has been adjusted.

»  After completing the above steps, the single bar object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the bar object and double click, or click
Properties in the Edit menu after choosing the bar object . At this moment, a property
dialog similar to that in rectangle drawing will appear.

Property[SingleBar] g

Froperty lDirect ] Variable] Color ] Dyr\amic]

e o M [EE
=
—
—

Range : You can set the Upper limit and the lower limit of the Y axis.
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Propertyl Diraect Variable lColor ]]Jynamic

Varisble |Analegl REGO
v as walue
¥ariable select
Bl arm
% finaloz
A Description

Analogl REGO

Variable: Select a variable for the signal bar from the variable library.

D S T T e e J ey

o o Color Font

2 Foreground

150

100

Type: PS_SOLID x

a0

Fill type: l—_|7

Yidth: (19 =
a
=] (=] Size
Fiams #idth |12
¥ I Hei ght 224

You can change the foreground, background color and size for the signal bar.

3.2.24 Meter of easyMonitor

Click Meter command button or EA in the tool buttons, and then move the mouse to
the picture editing window. At this moment the mouse shape will become a cross, and now
you can put a meter chart in the screen by clicking the mouse.

Lot AT 0 600
200 E1Y: T
: 108 588 :
: Uolts[U] : Volts
s e o e o
Analog1 REGA
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» To change the size of the Meter object , first choose it and move the mouse to any of the
8 green square dots on the frame of the Meter object. When the mouse becomes é’,
press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the meter object has been

adjusted.

» After completing the above steps, the meter object has default settings foreground
color(text color), background color and the size. You can modify these settings basing on
actual needs. To do this, move the mouse onto the meter object and double click, or click
Properties in the Edit menu after choosing the meter object . At this moment, a property

dialog similar to that in rectangle drawing will appear.

Froperty |‘.l"ariab1e] Color ] Tymamic I

Rangze

Min [0 Max  [EE
Scale Decimals |1 ¥ | Seale Hum. [B
Y¥alue Decimals |3 d

Caption Volts
it Y]

0k | cancal | Help

Range: Range set, you can set the Min and Max value.

Scale Decimals: Decimals set for scale value.

Value Decimals: Decimals set for the real time value.

Scale Number: You can set the numbers of scales here.

Caption&Unit: You can set the caption and the unit for the actual signals.

Property WYariable lColor ] ]ijarnic]

Varisble [Pmalogl REGD

Pl ¥ariable select

Description

Varfiable
Analagl REGO

Variable selection for the meter displaying.

98



Proparty | Variabls Color |Dymamic|

~Color - Font
Foregroumnd Select Font |
Backgr ound
Connec
Line

Heedle ~Line

Type: iPS_SDLID -

[

Fill type:
Width: |1 |
Fill color —_—
—~Size
plrans——— #idth |98
I¥ Display Height W

You can change the background, Foreground(text color), Text font and the size in the color

option.

3.3.25 Breaker of easyMonitor

Click breaker command button L in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you

can put break chart in the screen by clicking the mouse.

The background can be changed in the color option of the property dialog box.

Property[Breaker]

Direct I Variable Color I]:Ijmamic i

~Calar ~Font

roregonst [ | | seect ot |

L1 e -

Fill type: [~ o

Connect

Heedle

~Line-

Type: IPS_SDLID -




3.3.26 Switch symbol of easyMonitor

Click switch symbol command button % in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now

you can put switch symbol in the screen by clicking the mouse.

The line width can be changed in the property dialog box.

3.3.27 Transfer symbol of easyMonitor

Click transfer symbol command button 8 in the tool buttons, and then move the mouse to

the picture editing window. At this moment the mouse shape will become a cross, and now
you can put transfer symbol in the screen by clicking the mouse.

3.3.28 Fan of easyMonitor

Click fan command button & in the tool buttons, and then move the mouse to the picture

editing window. At this moment the mouse shape will become a cross, and now you can put

fan in the screen by clicking the mouse.

<
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»  To change the size of the Fan object, first choose it and move the mouse to any of the 8

green square dots on the frame of the Fan object. When the mouse becomes ‘%, press
down the left key of the mouse and drag the mouse to an appropriate position. Then
release the left key of the mouse. So far the size of the fan object has been adjusted.

»  After completing the above steps, the fan object has default settings foreground

color(text color), background color and the size. You can modify these settings basing on

actual needs. To do this, move the mouse onto the fan object and double click, or click

Properties in the Edit menu after choosing the fan object . At this moment, a property

dialog similar to that in rectangle drawing will appear.

~Graph

Property [FAN] |

Logic Color i

~Color

Foreground

~Format
% fHHEEE
g
g

[ 7 e a

[ T: ansparant

Property [FAN]

Logie |Eolor i

~logic condition

logie condition OUTFUT1==1 cee l

3.3.29 Button switch of easyMonitor

Click button switch command button ‘ in the tool buttons, and then move the mouse to the

picture editing window. At this moment the mouse shape will become a cross, and now you

can put button switch in the screen by clicking the mouse.
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OFF: ON:

»  Tochange the size of the button switch object, first choose it and move the mouse to any
of the 8 green square dots on the frame of the button switch object. When the mouse
becomes ‘f', press down the left key of the mouse and drag the mouse to an appropriate
position. Then release the left key of the mouse. So far the size of the button switch
object has been adjusted.

» To change the property of the button switch, move the mouse onto the button switch
object and double click, or click Properties in the Edit menu after choosing the button
switch object . At this moment, a property dialog similar to that in rectangle drawing will
appear.

Property[ButtonSwitchl] m

Property ]Action] Variable ] Color ] Tymami ¢ ]

& Button switch :

" Enife switch

" Gear switch

" User defined

You can select the default type switch, or Insert your picture with the “User define”

option.
. n . =
Property[ButtonSwitchl Property[ButtonSwitch] X)
Eropsrty |Action | Varisbls | Coler | Dymanic | Froperty | Aetion | Warible | Coler | Dymanic |
DN

" Button switch . @ " Button switch
(= Knite swii Tk " Enife switch
e teh 0 Gear teh

=

Set the action, then select a variable which need be controlled.
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Broperty [ButtonSwitchl]

Property Hetien l‘i’ariablei Color i DIynamie

~hetion
¥ Click down

[ Fopup

I Mouse mowe
Action define

Caption I

Action type iSmgle control =
arishle soures |RS232:COM[3]:441] =]
Handle varishle |00 bt

Handle vahie e I

{* State inversion

= |
e o

Select a variable for the status monitoring, it does not must be the same as the variable
in the action option.

Property[ButtonSwitch] X

Prnpertyi hetion Yariable ]Cnlnr ! Dynamici

—Alarm

(¥ Dizital when warisble :iv ‘

3.3.30 Valve of easyMonitor

Click valve command button ; in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you

can put valve in the screen by clicking the mouse.
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» To change the size of the valve object , first choose it and move the mouse to any of the

8 green square dots on the frame of the valve object. When the mouse becomes '%’,
press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the valve object has been
adjusted.

Property[VALVE] -

Property[VALVE] (]

Color Variahle ]

Variable 1sm 40z
e
1

Color | Varisble |

~Grap ~Color

A1

Fipe ON

Pipe OFF

I |

H
g
E
A
=
£
i

3.3.31 Slider shape of easyMonitor

Click slider command button ™ in the tool buttons, and then move the mouse to the
picture editing window. At this moment the mouse shape will become a cross, and now you
can put slider in the screen by clicking the mouse.

»  To change the size of the slider object , first choose it and move the mouse to any of the
8 green square dots on the frame of the slider object. When the mouse becomes ‘f',
press down the left key of the mouse and drag the mouse to an appropriate position.

Then release the left key of the mouse. So far the size of the slider object has been
adjusted.
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3.3.32 Pipe of easyMonitor

Click one kind of pipe command button = IFFSOX0OW 22 i the tool buttons,
and then move the mouse to the picture editing window. At this moment the mouse shape will

become a cross, and now you can put one kind of pipe in the screen by clicking the mouse.

| |
= ppe: I

| .
™ Connect pipe:

|~

e I | §

Ir Bend pipe:

"3Elbow pipe:



O

Rod:

L Rect pipe: I I

K Free trapezoid: m 7 a ﬁ B a .;_ -:.

Standard trapezoid:

IS Ellipse pipe:

» To change the size of the pipe object , first choose it and move the mouse to any of the

8 green square dots on the frame of the pipe object. When the mouse becomes '%’, press
down the left key of the mouse and drag the mouse to an appropriate position. Then

release the left key of the mouse. So far the size of the pipe object has been adjusted.

3.3.33 Data input

H#it

Click “data input” button in the tool buttons, and then move the mouse to the picture

editing window. At this moment the mouse shape will become a cross, and now you can put
object in the screen by clicking the mouse.

#i

Double click to choose the variable for the data input object.
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Aetion | Color |
hetion
[¥ Click down
[C Popup

IS Woties e

Action define

e =l
i IGPRS!LAFE j

Handle valee (" Fixed 0

£ State tvession

Lo | s |

AF and REG value can be set with this data input object. But the AF input leg must be no
connection.
For example:

In above program,AF1 and AF2 value can be changed with the data input object. AF3 value
cannot be changed, because there is a connection on its input leg.

e S

Veriahile: |GPR34_AF3
Bet value: |m

You can input the value which shall be set into PLC.

0K

3.3.34 Logic function bitmap switch

aoon

Click “logic function bitmap switch” button in the tool buttons, and then move the mouse

to the picture editing window. At this moment the mouse shape will become a cross, and now
you can put the object in the screen by clicking the mouse.
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O a i |

»  Tochange the size of the bitmap object, first choose it and move the mouse to any of the
8 green square dots on the frame of the bitmap object. When the mouse becomes'%’,
press down the left key of the mouse and drag the mouse to an appropriate position.
Then release the left key of the mouse. So far the size of the bitmap object has been
adjusted.
Double click the bitmap to enter into the property dialog box.

oo |
repernoccwgiil ==

Froperty |
Default Imagel Istart.bmp
—Logie list
Index | Condlition File ._:
E El
2
3
4
e =
& -
4 1iF | b |
Add | Edit l Delete | 1 | Down |
ITI Canecel | Help !
Al

Double click the rows to edit the condition and corresponding picture. There are total 50
Pictures can be changed with different condition. And the big index number has priority than
the small one.
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Bitmap logic

Logic: [sTART_F1=1
File: |
’
Edit Formula
E ]
E Analog| Digital + =
— HOT AND OF {
1 2 3 4
- 7 g 9

After, the logic edited, you can choose a picture for this condition, or keep it Null if no picture

to be displayed when this condition is true.

Property I
Default Imagel Istart.bmp
~Logic list
Ind Bitmap logic D) |é
A )
Figic START Fl1—1
2
2 || File: | =
5 x| |
el J i
Image select 1 gj
S E
—
1233.bmp 20140304174621.bmp blank.bmp
—— L.—_ﬁ e —
bottom.bmp car_l.png center.bmp =
__4‘ | I Cancel | |

For example, you can realize this function with such object like this,

F1=1, Display picture 1
F2=1, Display picture 2
F3=1, Display picture 3
F4=1, Display picture 4
F5=1, Display picture 5
Q1=1, Display picture 6
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3.3.35 Instant on button

Click “Instant on” button = in the tool buttons, and then move the mouse to the picture
editing window. At this moment the mouse shape will become a cross, and now you can put

the object in the screen by clicking the mouse.

» To change the size of the Instant on button object , first choose it and move the mouse
to any of the 8 green square dots on the frame of the Instant on button object. When the
mouse becomes ‘$', press down the left key of the mouse and drag the mouse to an
appropriate position. Then release the left key of the mouse. So far the size of the
Instant on button object has been adjusted.

Double click the Instant on button to enter into the property dialog box.

. Property[[nstantSw'%- k. _' i

Property VYariable 1

0O | Cancel Help

This button always keep HI status, if you press down the button, then it will be switch to Low

status, but after you release the button, it will switched to HI status again.

3.3.36 Flow

Click “flow” button in the tool buttons, and then move the mouse to the picture editing

window. At this moment the mouse shape will become a cross, and now you can put the
object in the screen by clicking the mouse.
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EEEEEEREEEEEEEEEEENEEEEEER
i Property[Flow] g

Calar I Logic I

—Graph Line

ok | cemcal | Help |

d

You can change the color and width of the flow in color table. And in logic table, you can set

the logic for the flow forward and flow backward .

Property[Flow] % |

Color Logic i

—logic condition

Forword logie I _I
;|

Baclword logic |

p
Edit Formula

| I5 0E_ F==1
Analog Digitall + | - | * | i | * |
HOT | AHD | OE | { | ] | ] | < |
el ol i e
| I A | |

1 — - — =
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3.3.37 Flat flow

Click “flat flow” button in the tool buttons, and then move the mouse to the picture

editing window. At this moment the mouse shape will become a cross, and now you can put
the object in the screen by clicking the mouse.

Property[FlatFlow] g . ! g ||

Color ILogic I

—Graph —Background color

¥ Tranzparent

—Frame line

Color
Type:

fidth:

—Flow

Color

Width |15—

0k | Caneer | Help |

The color of the frame line and flow line can be changed in color table of the dialog box.

Property[FlatFlow] ; ! :g m

Color Logic I

—logic condition

Forword legic ||

[ L

Baclword logic I

0K I Cancel Help !
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3.38 Modify block parameters

Click *modify block parameters” button = in the tool buttons, and then move the mouse to
the picture editing window. At this moment the mouse shape will become a cross, and now

you can put the object in the screen by clicking the mouse.

Property[BlockParam] ﬂ
Property |
Caption [[BO01] [On-Delay1l1]
Dewice [£5232; CON[3] Adar [1] =l
Block typs [On-Delay =l
Block parameter  |1(0n Delay] =1
Block Ho o0 =] ¥ Block type s caption
~On-Delay - :
o o
0--99 0--99
S

Caption: The default text is combined with the block humber, block hame and the selected

block parameter. You can modify it as well.

Device: you need select one device which created in the project device list.

Block type:The function block number in your PLC program. The available function block:

Up/T own counter

On-fOff-Delay Hours Counter

Betentiwve on—Delay Thresheld trigger
Wiping relay (pulse cutput) Analog comparator

Edze trigzered wiping relay Analog threshold trigzer

Azynchronous Pulse Generator
Bandom Generator

Stairway lighting switch Analagz MUK

z watchdogz i
g differential trigger

Multiple function switch FT controller
Weeldly Timer Analogz Ramp
Yearly Timer Analog Math

After the connection is established with the PLC, then you can click the object to modify the

corresponding block parameter.
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Property[BlockParam] @

Froperty l
Caption | [B003] [On-/0££-Delay] [2]
Device [R5232:COM[3]: Addr [1] =]
Elock type JDn—fof—]]elay __'__J
Elock parameter [2[0FF Time (TL)] R4

Elack Ha. BOO3 v | W Block type as caption

-0£ff Time (TL)

5 : ]59

0--99 0--59

et

To click “get” button to read the value from the PLC.

Set

To click “set” button to set the value to the PLC.

Chapter 4 Example showing
4.1 Create new device

Create a new project by click project -> new, then:
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g 8
[ Broject Edit Variables Drawl
:.E'F-_";ﬁ HE »E2R

= Basicllﬁ Bitmap | [BH Tine |
I E e ¢

- x

I

= D Tindows
SystemStart
B8 Viewl

B8 ¥iew?

E¥ CurveView

= D Devi

& RS232:COM[2]: Addr [2]
(Bl RS23R: COM[3]: Addr [3]
B RSZ32:COM[4]: Addr [4]
&5 RE232:00M[S]: Addr [5]

D Script

There are 5 devices in default, here we delete 4 of 5, we only use one Device for

communication.

f ] Dewice
'E'H+r%
DS A1t deylce

Delete dewvice

. Comm ]Data 1

W use devies

Fame: |R5232:CDI'|'I[1]:Addr[1]

hddras: 11 Protocol JHodbus-RTU __'J
Model'  [gir-17 Series v ||ELC-12DC-TA-R-H =
Ext. “7 Ext. 1 _'J

Comm type -
+ R5232 Py jSI

" RS485

(~ EthernetfGFRS,WIFI

€ 1 caes |

Here, we use a ELC-12DC-DA-R-N CPU and one extension(ELC12-E-8DC-DA-R), the

communication port is port 3, baud rates 9600.
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4.2 Create new data for the devices

Establish data in the data option:

Jomm Lata |
Jndex | Type TP Eet Address Count Friersis & i
oz I 1 i] 4 u}
o3 Q u} 0 4 1] Edit
od 0 1 0 4 1]
i AT u} a 4 ] Delete
g AT 1 0 4 1]
or AR i} 0 Z u]
o F 1} a 16 1}
o8 F 1] 16 16 1]
ia AF i) 0 16 i)
if AF u} 16 16 u}
iz 1] 1] 0 16 1] hal

OE | Cancel

Now we can add the variable in the variable value based on requirement, the example
program as below:
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We will create objects to monitor the below objects.
1.Digital inputs/outputs status, digital flag, M.

Note: the input leg of the output/digital flag block if did not be linking with other block, then
its status can be changed with a button in SCADA, In the example program the Q013, Q014
can be controlled with SCADA.

2.Analog inputs , analog outputs,analog flags, and AM

Note: we can also set the AQ and AF value, in the SCADA if the input leg of the block(analog
output and analog flag) is not connecting with other blocks. In the example program, the
AF5,AF6,AF7 can be set value between “-32767" and “32767"

3.REG
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Note: The REG value can be read and also can be set, but it is the current value of the blocks,
for example, if you set a value to REG2, then the current count value of BOO3 will be changed,
but the on/off threshold and the start value cannot be directly changed via SCADA, but you
can use the “reference” function is the block.

As below:

E009[M9] [Up/Down counter] @

Parameter ] Comment ]

Elacl name: [ Show Parameters

On Threzhold 1/ -B002 [M2] [Up/Down counter] L] IReference

Reference

DEE Thesehold |{;BE|E|3 (M3] [Vp /Down counter] L]

Start Value L _:| Reference

[ Retentiwity [ Frotection hetiwve

0K I Cancel Help

If you want to change the ON/OFF threshold value via SCADA, then you need to change the
B002 value(REG1) for the On threshold, and change the BO03 value(REG2) for the Off
Threshold.

4.3 Add the data into the variable database

We need add all the variables into the variable database via the menu “variable”.
Note: Only the data in the variable database will be read from the devices.
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Variabhle define

x]

|Variable MHame

Index | Global/device | Scan.-’upload| Froperty | Source

1 WET:FORT[3333]:Addi1] Scan Digital Qom

= WET:FPORT[3393]:Addi1] Scan Analog REGO

2 WET:PORT[E899):4ddi(1] Scan Drigital 1005

4 WET:FORT[3393]:4ddi[1] Scan Digital F2

15 WET:FPORT[3333]:Addi[1] Scan Digital F4

E MWET:PORT[E899]:Addr1] Scan Drigital F&

7 WET:FORT[3393].4ddi[1] Scan Diigital Fa

8 WET:FORT[3333]:Addi1] Scan Digital Qom

| MWET:PORT[E899):Addi(1] Scan Drigital Qooz2

10 WET:FORT[2893]:4ddr1] Scan Digital Qoo3

11 WET:FORT[3333]:Addi[1] Scan Diigital Qood

12 MWET:PORT[E899):Addi(1] Scan DCrigital 1001

13 WET:PORT[E899):4ddr1] Scan Analog Al001

14 WET:FORT[3333]:Addi1] Scan Analog AMT00

15 WET:FPORT[3333]:Addi[1] Scan Analog AM23

16 WET:PORT[E899):4ddr1] Scan Analog AM135

17 WET:FORT[3393]:4ddi1] Scan Analog AMB4

18 WET:FORT[3333]:Addi[1] Scan Analog AM7E

15 WET:PORT[E899):Addi(1] Scan Analog Ahd136
Eatch add add Delete Clear

QuUTPUTH i]
Test 1}
MET:PORT a
MET:PORT[E899]4dd1] F2 a
MET:PORT[E899]Add1]_F4 a
MET:PORT[E899].4dd1]_FE a
MET:PORT[E899].4ddi1] F& a
MET:PORT[E899].4dd 1] G001 a
MET:PORT[E899].Add1] G002 a
MET:PORT[E899].4d41]_£003 a
a
a
a
a
a
a
a
a
a

sddif1] 1005

NET:PORT[2393] Add{1] G004
NET:PORT[8899] Add{111001
NET:PORT[595] Add{ 11 A1001
NET:PORT[S899] Addi{1]_AM100
NET:PORT (9899 Addi{ 1L AMZ3
NET:PORT[S899] Add{ 1AM 135
NET:PORT[S399] Addi{1] AM54
NET:PORT[S899] Addi{1L AM TS
MET:PORT[S899] Add 1] AM136

o]

Cancel

Default value | >

" Batch add” : This button is used to add all the registers in to the variable database with

once operation.

“Add” : You only can add one variable once.

“Delete”: This is used to delete one variable once.
“Clear”: This button is to clear all the variables one.

You can double click the items to select the

“device”,"Scan/upload”,“digital/analog””Source/registers”, and input the variable name and

the default value for a certain register.

Note:

The "SCAN” means the easyMonitor sends data to PLC, and PLC do response.
The “Upload” is only for the GPRS data upload mode, so such mode is only for the EXM GPRS
connection, and EXM need use the "GPRS DATA upload” in the program and select the
“custom MODBUS”

4.4 Create widows as your requirement

Here we create serval windows for how to read and set the register value.
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ED Tindows
= 25| Faram Edit wiewer
-- Data | Delete viewer

i -- Curve‘l.rl aw

ED Device

™ e TR e |

We can edit the viewer caption by right click.

view x

Caption: iICI status momtoring

-~ Type

g raph
£ Cuves

{7 Diatahase

£ Eeport

10 status monitoring window

I1 I2 I3 14 I5 16 I7 I8

I11 I12 I13 114

ANALOG INPUT VALUE:
All = @CPUAIL ;
AI2 = @CPUAI2 ;
AlI3 = @CPUAIS ;
Al4 = @CPUAI4;

a
CPOAIL CPORIZ CPORIZ

COM STATUS:

Ext_Ql% ExtQ%

Q000 -9

QL QR: RS 1 ofrfo= @

Qi1 Q12 Qi3 Q14

2014-03-18
10:02:48

We can use “3D circle” object to display the status of the digital status, here we set as default

for the digital I0s. HI/ON = RED, LOW/OFF = GREEN.
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Property[3DCircle] [’5_(|

Variable |Color | Dymanic |
Yariible |
¥ as value
r' s .
Marn-
I Alarm j 100
€ Analoz o ]7

Select the relative variable and tick up the “as value” option

Property[3DCirclel &l

Variable Color |Dymamic|

Color -

OF Color

Type: [PS SOLID
Hidth: |1 i

Fill type: ﬁ 1

~Size-

i wan [
| Height [
ok | Canead | Help |

You can change the ON/OFF color as you need.

ANALOG INPUT VALUE:
AlIl = @CPUAI1
Al2 = @CPUAI2
AI3 = @CPUAI3
AI4 = @CPUAI4

- mE mE

We can use a multiple text to directly the analog input values based on the fixed format with
@variable.

Property [BAR] &l

Froperty ]]]irect 1 Color ] ]]ynamic]
Related wariable .

Bar 1 CEUATL Selact

Bar 2 ]Clelz Select]
Bar 3 1CPUAI3 Selact
1000 |

200
B00
400
200

i Bar colour -

Bar 1 coleur - Bar 2 colour -
bar 3 colewr - Back colour I:l

~Scale -

CPOAIL CPOAIZ CHROAIS Upper limit |00 Lower Linmit ]U

We can use a bar object to showing AI1--AI3 of CPU simultaneity
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Property[Buttonl |£

Title |Action|jl:olor ID}’namicI

¥ariable
W as value

|7 Click down when val_uezl.

—hlarm

{* Digital when variable = |I:I

[ Marm 1000
lpper

{~ hnalog
IU
Lower
wlarm =rnd I LI

Caption

st e Lingle control ;I
Varishle somrre | FS2I2:COM3]:Add{1] |
e IExthS(QDlS] j

Handle vahae  Fixed |n.|:u:n:n:n:n:|

{* State inversion

0] Ca.ucel |

We can use the button object to change the digital status.

Note: The input leg of digital flag or output block must be not connected with other blocks,
then the digital flag and output can be changed with the button object.

KL
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{____;j___u )
@0

Q13 Q14

Parameter setting window

Digital set

set F5

set 013

i

set 014

Digital status settings

AF value set

REG walue set

BN BO0S(RENS] B011(REEEDR002(RE G1)

0 500
400
300
i 200
100
[l||||||||||||||||||||||||||||||||||||||||||||||||||||||||||
10:39:10  10:39:30  10:39:50
: |
300" -
ve0” " 400 -
00 500,
Volts[u]
o [ I 600
9

We can use the “button” object and the “button switch” object to change the digital status.

We can insert a gif object into the screen, then if the digital F4 is switched on, then the gif

picture will be played, so we can get a animation.
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AF value set

=S8 REG value set

BN BO09(REMS) B011(REEEDB002Z(REG1]
0 5qu

Ann

Set AF value, you can click the area of the AF data input object under monitoring mode, then
one data input box will be pop up. After input the data, confirm with click "OK” button.

AF value set

e
AF6; D E
AEr D E

REG value set

Note: The input leg of analog flag or output block must be not connected with other blocks,
then the digital flag and output can be changed with the button object.

Set REG value

you can click the area of the REG data input object under monitoring mode, then one data
input box will be pop up. After input the data, confirm with click "OK” button.
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Input frame

Varishle: ‘ EG value set
QE
Sat wahie: |1':":":||
0
0
]

REG value set

00
400
3Joo
200
100

The easyMonitor can read the variable value includes AM,AF,AI,AQ,REG. The “data reading”
window is using the “Rect” to read all the analog variable value.

125



&5 AME AT 4M3

AR AF2 HES AR
AF1 AF2 AF3 AF4
REGIL1 REGLZ REG13 REGL4

|BDDl-2!REGll‘g| |BDE1131 R.EGlZ!l |BOD];3!REGlZ.[| BOO15(REG14)

41 412 401 A02

Property[Rect] [.X

Title IColnr I]ijamiu:l

Variable IE _I

W az walue

LTk down when valus=]

—Alarm
{7 Digital when wariable = |D
[ Alarm |]IJIL|L‘-

Upper

% bnalag g
Lower |'I
Mlarm sound I ;I

You only need to select the variable from the variable database, and tick up the “as value”
option. Then the value will be read under the monitoring mode.
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There are a default

“Cureviewer” window to show some analog values.

r Flot 1 r Plot 2
1200 0
500 400
HI Alarm HI Alarm
300 200
L0 Alarm !l [T L0 Alarm - —
o LTV T T T T B
13:37:12 13:37:32 13:37:52 133712 133732 1337:62
r Plot 3  Plot 4
ann a0
400 400
HI Alarm HI Alarm 1
200 200
L0 Alarm e el LO Alarm ; DR
QL T B
133712 133732 133752 133712 133732 133752
 Plot 5 r Plot &
00 10
[rowess]|  ®
400 400
HI Alarm HI Alarm
200 200
LD Alarm " — L0 Alarm B e
QL T B
133712 13:37:32 133752 13:37:12 13:37:32 1337.52
] - value
% 500
300
] W [f Cosa € andes [ e
UL LD L
13:41:11 13:41:41 13:42:01 i e SE S 34122 13:41:38 1z
™
Y CPUAT4
1000 M1
Varihle  |CPUAIL gg
800 Max [lso0 P4
AFS
500 Min g AFE
300 AFT
i HI Alarmn el
LO Alanm 100 AME
200 AT
— —— O | St | g | —
AL BOOZ (REGL)
13411 BO03 (REG2) 34122 13:41:38 1z
[ | |Booa REss)
BO11 (REG10]
E001 (REGO)
s BECT
AQooz
004 I: E0012 (REG11)
e [ BO013 (REG12)
E0014 (REG131
i |: BOD15 (REG14)
<
400 E :
200
S r | — A —i
B
128512 138532 125552 138512 138532 1z

Click the “Property” button, then you can select a variable and set the Max AND Min value.

Now you can startup monitoring the device.
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4.4 Monitoring with serial connection:

Hardware connection:

easyMonitor Directly connection use R§232 cable or
RS485 module(R8232 to R8485 converter
needed on PC end)

-
MySQL
database

Device settings

- Comm ]Data ]

¥ use device

Hame: JESZSZ:EDM[S]:Addr[l]

pddres: |1 Frotocael |Modbus—RTVU |

Model:

ELC-12 Series v ||ELC-12DC-DA-R-F = |
Ext. ||7 Ext. 1 j

—Comm type
{* BSZ3Z P 3
: Qe00 - ]
" ES485 R

{™ Ethernet/GFRS/WIFT

o Tr adi e |

ELC/EXM series CPU

After all the connection and the settings are ok, we only need to start the monitoring with

click the “start/stop” > button.
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ANALOG INPUT VALUE:

AI1=0;

AI2=0;

AI3 =0;

AI4 R O I % CPURIL CPUal2 CPURIZ

1 =
o - @ @0

mA m" m?2 A F ™14 min ™12 m1A

You can add a digital flag(example is F1) in your program, then in the window, you will see the

status is turning on/off, otherwise the communication is failed.

Note: If there are multiple devices need be monitored, we must set them with separately
address, If there are 2 or more same address in the devices, the communication would be
work incorrect.

4.5 Monitoring with Ethernet/GPRS/WIFI connection

4.5.1 Device works as server

Hardware connection(this connection is only applied to Ethernet and WIFI, GPRS is not
available):

easyMonitor Communication by Ethernet connection and the PLC works

as server. the server software is also not reauired.
Client
I

<SR
MySQL
database

ELG/EXM series CPU

Ethernet modem
would be set as
server mode

In this case, the easyserver does not need, easyMonitor can directly connect with the device
with Modbus TCP.

This connection are both applied to LAN and Internet, but we need a static IP address for the
device end if Internet connection is required. Here we take an example for the Internet
connection.

Example,now we have a static IP address here “221.226.289.74" connected to router, Then
we set the Ethernet CPU works as server, the IP address is 192.168.0.133 in the LAN, the
local port is 5001. So we need forward the 5001 port to the IP *192.168.0.133".
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Then our easyMonitor works in the Internet will be connected to the IP 221.226.189.74.

. Comm ]-Ilata 1

v use device

Fame: 1N’ET:PDRT[SDDI]:Addr[1]

Addeass |1 Protocol |Madbus-TCF -

Model:

|FLo-12 Series v ||ELC-12D0-DAR-H |

Ext. v Ext. 1 o

Comm type-
 Rs23z Py 5001
¢ Rs485 i = K|

{# Ethernet/GFES/HIFL

& TP addres | 281 . 228 . 189 . T4

(" Domain name |

Cancel

CPU address is 1

Protocol :MODBUS TCP

PORT:5001

IP address: 221.226.189.74(static IP address for the router which connected with Ethernet
CPU)

After all the connection and the settings are ok, we only need start the monitoring with click

the “start/stop” > button.
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ANALOG INPUT VALUE:

AI1 =0;

AI2 = 0:

AI3 =0; Z00f - mm s
AI4 =0; U TCRRIL cruaiz cRuas

EE
0000 ~°* |oo0e0

F .3 IaER] 1D m12 mAA

You can add a digital flag(example is F1) in your program, then in the window, you will see the
status is turning on/off, otherwise the communication is failed.

Note: If there are multiple devices need be monitored, we must set them with separately
address, If there are 2 or more same address in the devices, the communication would be
work incorrect.

4.5.2 Device works as client

Hardware connection(this connection is applied to Ethernet ,WIFI and GPRS.GPRS function of
EXM only can be applied with such connection):

easy server

easyMonitor !.

Client
= Static IP address/Domain name needed =

" bew

MySQL
database

ELC/EXM series CPU

Ethernet modem would
be set client mode

In this case, we need use the easyserver for transmitting the datas between easyMonitor and
devices.

This connection are both applied to LAN and Internet, but we need a static IP address for the

easyServer end if Internet connection is required. Here we take an example for the Internet
connection.
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Example,now we have a static IP address here “221.226.189.74" connected to router, Then
we set the my PC(installed the easyServer) IP address 192.168.0.133 in the LAN, then we

forward the 5001 port to the IP “192.168.0.133" in the router.

We also need forward another port number for the easyMonitor, here we have installed the
easyMonitor and easyServer on a same PC, so they are in local, we do not need forward the

port number for the easyMonitor anymore.

easyServer — [ComDatall]
File Edit ¥Yiew Window

D@ H| &2 |
! G RO
gmﬂm

Help

1 I o I 14
devicel urnlorosiar unlcrnosar
) )
| |
1 F i
i i
I unkronar I

The default port number is 6365 for easyMonitor, 6364 for the device, so here, we need to
change the device port to 5001. Then the device would connect to the server 221.226.189.74
5001.

Server port rg Server port &|

Seada port [6363 Seada port [63ks
Device port 6364 Device port 15["]1

Cancel 1 ] Cancel I

After the easyServer started, we can set the start way by right click
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hettings E |
[~ Server mmn type

" Funwith system

(% P with easyhomtor

7 Mamal nm

0K Cancel

There are 3 run types for the easyServer.
a. Run with system

b. Run with easyMonitor

c. Manual run

The device settings need be changed as below:

. Comm ].Data 1

¥ use device

Wame: JH'ET FORT[5002] : Addr [1]
Addres: 11 Frotocol |Modbus-TCP -]
Madel:

[ELC-12 Series  »||ELC-120C-DA-R-H  v|
Ext. |V Ext.1 ~|

—~Comm type-
" 5232 Port 15355
" RS485 e '

{* Ethernet/GFRS/MIFI

@ IP addres | 192 186 . 0 . 133

7 Domain name I

Start the server

Serwer port
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egsySenvern ELLCOS, @Address: 192.168.0.133'is running on port app/plc: 6365,5001 Connected:0, 1

Se"’Ve"’!.------------------------------mScadﬂ

| Som— 1 = F— I T 1 — 15— |
I I I I I I
I I I I I =l
I I I I I

I I I I I I
1> = I I I I
I I I I I I
=] I =] =] =] =|
I I I I I I
I I I I I I
I Sicons I e 1 1 | |
I I I I I I
I I I I I =l
I I I I I I
I I I I I I
5 = [ I [ I [

The device will be connected with this server, and you can view which one in the easyServer.

Now you can start the easyMonitor by click the “start” > button.

I1 12 I3 14 IS I6 17 I8 I11 112 I13 114

ANALOG INPUT VALUE: ' Il COM STATUS: @
AI1 =0; '

AI2 = 0; il
AI3 =0; oo I ;
AI4 = 0 ; CPUAIL1 CFUAIZ CPURI3

B

@00 S 000

ol e e oFF/0 = @ Gl enioriania nng
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/easyServer — ComDatal =]
File Edit View Window Help Server

Dl » =R & %=

& ComDatal

| 00000523 AddData_App(2)——-16:01:06 0
00000524 ===5>plc, length: 0012, data: 0
00000525 AddDat _Dew(2)-—-16:01:06 0
00000526 dev index = 0, socketID = 0, receiwed——16:01:06 0193
00000527 ===>app. length:0010 . data: 00 02 00 00 00 04 01 01 01 09 2014-03-18 16:01
00000528 AddData_App(2)-—-16:01:06 0
00000529 ===:plc, length:0012 data: 0
00000530 AddData_Dew{2)———16:01:06 0
00000531 dev index = 0. socketID = 0. received—-16:01:06 0287
00000532 ===3app, length: 0017, data: 00 04 00 00 00 OB 01 03 08 00 O
00000533 AddData_App(2)-—-16:01:06 0287
00000534 ===3plc. length: 0012 data: 00 05 00 00 00 06 O1 03 05 00 O
00000535 AddData_Dev(2)——-16:01:06 0349
00000536 dev index = 0. socketID = 0. received—-16:01:06 0381
00000537 app, length:0013 data: 00 05 00 00 00 07 01 02 04 00 @
00000538 ata_App(2)———16-01:06 0
00000539 ===:plc, length: 0012 data: 0
00000540 AddData_Dewv(2)——16:01:06 0
00000541 dev index = 0, socketID = 0, received—-—16:01:06 0490
00000542 ===3app. length: 0011, data: 00 06 00 00 00 05 01 01 02 OO0 O
FUUUUS43 AddData_App(2)——-16:01:06 0430

115
0 02 0000 00 06 01 01 00 00 00 04 2014-03-18
162

224
0 04 00 00 00 06 01 02 04 00 00 04 2014-03-12
240

=

ap o0 00 0o oo

=1

02 2014-03-18

=

a0 00 2014-03-

=

381
0 06 00 00 00 06 01 01 06 00 00 10 2014-03-18
443

=1

2014-03-18 16

You can click the button = to see the communication data between easyMonitor and the

devices.

When you communicate the EXM with easyMonitor, you also need set the easyServer as
above, then to set the IP address of the easyServer(Static IP address/domain name) and the
port number in the GPRS parameters

Sypstem
Timeaut |10 |I‘--1inute j Device name: | TOC
APN: 1|:mnet

¥ Connect to ethemet when power on

i~ Target Metwork,

Part !EI:IEH

F ExMasClent |  IPAddess | 221 - 226 . 183 . 74

" Domain Mame I

Notes: 1.The GPRS connection is wireless and the communication speed is also not too fast,
so it is not suitable for the communication speed requirement.

2. GPRS communication data will also take some cost for the SIM card provider.
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Chapter 5 How to use GPRS data Upload function

This chapter is used to describe how to use the “"GPRS upload” function to transfer the data
from EXM to SCADA. And this chapter contents is only can be applied to the EXM series CPU.

easyMonitor

Client
| m— T

I]

-
MySQL
database

We will make an example to show you how to configure in eSmsconfig and easySCADA.

easy server

address/Domain name needed

Transfer data
through GPRS

RATEN

In eSmsconfig, you can find a function block named “"GPRS Data Upload”

--Mlg Sms Message Input Out

-] GPRS
| Tty GPRS Data Upload

----- Tl GPRS Connect
B To. GPRS Disconnect
=177 Basic

EXM CPU Upload

data to server

You can configure the remote IP address(the static IP address of the easyServer) and the port

in the property dialog box of GPRS Data Upload. Then we need select “custom Modbus”

option ,then select the data shall be transferred to SCADA.

Note: In this example, the static IP address for the router connected with the PC with
easyServer is 221.226.189.74, then in the router we forward a port 5001 to the easyServer
PC(This PC IP address in LAN is 192.168.0.227).
Hence, in the GPRS data upload function block we set the remote IP address is
221.226.189.74 and the port is 5001..
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Paranster 1 |Parameter 2 | Conment |

Flock name | ¥ Show Parameters

Hetwork Params

B systen SERERTE S

5 Co=tomize Part: 001

i IF hddress 221 . 226 . 189 . T4

" Standard Modbus * Custom Modbus

Slave Address |1

Data Register Index |}{1gh Low vl

Command |15 Write Multiple Coils

Register addr: |0 Count |1

@ hute | pars aaae [T 7] Adieess| [T
€ Manual ‘ |g_ Ig_ oy

Farameter 1 Farameter 2 |C-:nrnmen+.|

Identification String |GPES

W Digital Input Address ||'I' Count
W Digital Output  Address ||'3' Count
W tnalog Input Address ||'3' Count
[T Analog Output Address ||'3' Count
[T Flag Addrezs |IEI Count
W Analog Flagz Address ||'3' Count
~n Eaa |||:|— s
[T hnalog M Addre=s ||EI Count

T

Then you can add a device in easyMonitor.

-] Device
- By RS232:COMI3T:-Adr1]
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[ Comm i"Scan data1 huto upload]

[~ use device

Wame: ]GPRS Con

fddress: |1 Frotocel |Modbus-TCE v1

Model:  [EyW-12 Series v |[EXM-12DC-DA-RT-GHIE v |

| Ext. ™ Ext.1 -

~Comm type-
 R323P Bt 15355
" ES485 BES: o800 ‘]

% Ethernet/GFRS/WIFI
(* IP addres 19z 168 . 0 . 22T

{” Domain name ieasy—test.xicp.net

—Comm =peed-
i The fastest speed

€ The =pecified speed o Second v

‘ J T ‘ ’TI Cancel ‘

The IP address is the PC IP address which installed easyserver(so the IP address might be the

local IP address 192.168.0.227, not the static one). The port is the same one in easyServer.

el Server port M

Start =
o Scada port 6363
top
Devicspest  [5001

Settings

| Server port

=

Click the “Auto upload” table to add the variables .

Note:

Add the variable here need be totally same as the configuration in the GPRS data upload
function block in eSmsconfig.
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Device define |

Comm | Scan data HAuto upload

Data define

|ndex Caption
Identification String |GFES

0
0z GPRS1 | | T ———
= GPRS2 ¥ fiizital Trput Address |0 Lmt

04 GPRS3 I
e | ¥ Digital Dutput Address I 0 Count

05 GPRS4 |

L GPRSS M @ snalog Input Addvess ||D Count

07 GFRSE h

i} GPRST | [~ inaleg Output Address ||D Count
09 GFRSE

o pddress | [0 Count

10 GPRSS [Ii=e [hdress | aun

¥ Analog Flag hddress ||U Count

™ n Address ||D Count

[~ Analog W MID Count

D |

Cancel

:

&dd Edit Delete | 0K | Canecel |

Then you need add the variable into the variable library. All the variable for the GPRS unload
need be select “upload” in the variable table.

Variable define T - i

Index | Global/device | Scanx’uploadl Froperty Source | Yariable Mame Default value -
116 R5232:COM[3].Add1] Scan | Analog REG10 R5232:COM[3].Add1] REGTD 0
7z RS232.COM[3LAdd1] '_Scan Analog |REGM RS 232.COM[3L.Add{1] REG1T 0
118 R5232.COM[3LAdd1] | Scan | Analog |REG1Z | RSZ32.COM[3LAD[1] REG12 o
113 R5232:COM[3}Addi1] | Sean :Analog |REG13 | R5232:.COM[3Add{1] REG13 o
Bl 120 RS232:COM[3].Add(1] Scan | Analog (REG14 | RSZ3Z2COM[3[AMd{1] REGT4 o
121 R5232:COM[3].Add1] ..Scan Analog REG15 R5232COM[3]Add1] REGTS 0
122 GRS COM Upload | Analog | Alo01 |GPRS_AIT o
123 GFRS COM | Upload :.t‘-‘malog | Al0D4 | GPRS_Al4 o
124 GFRS COM Upload | Analog |AF2 |GPRS_AF2 a
125 GFRS COM . Uplaad Analog | AF5 GPRS1_&F5 0
126 GPRS COM Uplaad | Analog | AFE | GPRSZ_AFE o
127 GPRS COM | Uphoad :Analog | AFT |GPRS3_AFY o
128 GPRS COM Upload | Analog | AFg | GPRS4_AFE o
129 GFRS COM ' Upload Analog | AFS GPRS5_AF3 0
130 GFRS COM Upload | Ainalog |AF10 | GPFRSE_AF10 o
13 GPRS COM | Upload :Analog AR | GPRST_AFT1 o =
132 GPRS COM Uplaad | Analog AF12 |GPRSE AF12 o -
133 GFRS COM ' Upload Analog (AF13 GPRS3_AF13 0
134 GEES COM Scan |
Eatch add Add Delete | Clear | [0):4 | Canecel |
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Now, you can put objects in the monitor interface, and select variable for them.

EPRS_I1 GPRS_IB
GPRS_Q1  gPRS_Qu
GPRS_AI1 GPRS _AI%4

2345

GPRS_AF2

(33 UC
L.l 1]

FEGE TH

Figm = 0fF " Timeui=00: UUS
05 00+

01:00s+

fEne HLGHaE] Ba1a]
= by i
% i

0500+

05005+

B B3T3
1 o i
- 1 % o
L =5

000 5
i Vo) Enza[mm(mq

L e
i [ [
BEGA2
Fgm = 0| TimeDut=00-00 s
05005+

REG21: | -
Bem =0
05005+

REGZ3: | -

] BO2E[M24]

B u""-.=" s

1
1003+ | Soi7m

i ﬁ;ﬁmgﬁ” 00 sy ML?S]
P
imeut ST il

BOz8[M28]

=
Prin = :1'

EO15[15]

GPRS_AFS

GPHS FIF1E1

AF5

..

000

GPRST
AFS

BO33M33] 7000

B340 34]

nnnnnnnnnn

AFE AFT AFS

4000 5000 5000 ]

GPRS8 1

AFT0 AFTT AF12 AF13 1
.

2000 5000 10000 11000 |

GPRS3
EO1313)

Start the easySever, you can see the easyMonitor is available.

E ComDatal

devicel W vnxnow W vrxnow

W vnxnow

S"'“! Illlllllllllllllllllllllllllll!. .
— E:

#6 “1 “16 “21 “26 t

W vnxnow

Il voxnow

T | B HHH | B HHH

1

| B HHH

1

o 2

w1111
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If the GPRS Data Upload function block in the EXM is triggered, and the easyserver get the

datas from the EXM, then the picture of the EXM will be available as well.

3 easyServer - ComDats
File Edit View Window Help Server

[Ded s 2R[&] 7=

easyServer: admin-PC, @Address: 192.168.0.227 is running on port app/plc: 6365,5001 Connected:1, 1

4] ComDatal
Sm“‘! llllllllllllllllllllllllllllll!.“sme"“
]
S 11 1S 21 26
R R L L T U
|| W || || |
- [T - - - -

y the corresponding status or value as follows:

GPFRS_AFS GFRS_AF18
mnlLin arrn
L ILIL LILILIL
GPRS AFG GPRS_AF11

» izl FEEEE

GPRS 01 GeRs_gu KRR R
. . GPRS_AF7 GPRS_AF12
Cirrn (Frn

GPRS_AI1  GPRS_ ALY el el L (LI

GPRS_AFS8 GPR3_AF13
OLILiL IHIEHEHH

(i1

I L L

GPRS_AF2
GPRS_AF9

L

NN

Chapter 6 How to update a setup for end user?
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6.1 Compile the project and create a setup file

After you finished your project test and want to supply a version for end-user.
Step 1: Click the menu Project->Compile..

E easyMonitor - [SystemStart] -~ - - - -

- & ——
B[Prcjed] Edit Variables Drawlib(l] Layout Database View Help
B New adn (O OG L mEREF & S
fieed Open... Ctrl+0 ]
/: Close E = I
; Save Ctrl+S
g Savehs. V. 1.04
E‘ Print... Ctrl+P E I_ = _|
- asyLine AHU
rint Setup...
E| User manage
U EPPT FAHU2 ———— ~System — =
1 ompile... r . r .
1 365078 Easyline AHU - V1.04-3.ezpj ACtlve 5 On/Oﬁ
2 C:\Users\..\READ REGD.ezpj !Eﬂ Ll Controc! % / IEH LI Pump £
3 C\Users\..\Desktop\Test.ezpj g ROOI’TI /éRH 1 cy max RPM IEHq
4 CA\Users\..\Desktop\111.ezpj %RH r Ala rm High %RH - o " '
Bt %RH * Alarm Low %RH ¢ , .
Time f. service
Duct%RH €34 | Duct%rH  i23M
Alarm %RH g Alarm %RH ‘
Alarm
Step @3 | | step B | | High flow §
Valve 1 r Valve 1 r High RPM b
Valve 2 - Valve 2 q Freq. Inv. -
Valve 3 g Valve 3 4 External r
Solenoid valve clicks Solenoid valve clicks Hours
Valve 1 @Clickl Valve 4 @Click4 System @Hours_sys
Valve 2 @Click2 Valve 5 @Click5 Pump  @Hours_pump
Valve 3~ @Click3 Valve 6 @Click6 Oil @Hours_oil
Duct AHUL % 1234 inlet%rH  I23M Solenoid valve clicks
Valve4 @y
Room AHU1 & IEHLl Inlet & IEHH Valve 5 @clicks
Valve 6 @Clickb

There is a .bin file will be created, click ok.

' ; * ?
Compile - &J

'6' The file G\SEPIE\20170309,365078 Easyline AHU -
WY V1.04-3.ezp| convert to GA\EEFRE20170309,365078 Easyline
AHU - V1.04-3.bin
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L

G:\EEPIE 201703094 365078 Easyline AHU - .
Pr-:-ject file | V1. 04-3 bin

—

: : Test
Project name: I Create
SIF - i
Caption:
Yer=zion: el
Company: SDFA

Company website:

Publisher ID: cnfl 234
C:h =

(utput directory |

Output file name: eazyFublich

license. txt -
Licenze file |

0%

Compile begin . ... .. -~

In above dialog box, you can edit the setup name, version number and Publisher ID(This ID
will be used when getting register ID).
Click “Create”.
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I — o | s |
5 conse =
£ e

G: \EREMIE 201703094365075 Easyline AHU - .
Pr-:-_iect file | V1. 04-3 bin

-

i ; Test
Project name: .
SIF "
Caption:
1 Ver=zion: II-D-D-D
Company: ISDFA
Comparny website:
Fublisher ID: enfl234
(B =
Output directnryl

Output file name: IEEEYPUbliEh

licenze. txt -

License file | Exit |
100%

defined: “en”. #
Warning: “CopwMode; alwaysskipifzameorolder” is deprecated and ignored in this
verzion of Inmo Setup. It is now the default behawior

Successful compile (T.098 sec)]. Resulting Setup program filename is:
C:%easwFublish. exe

Compile End. ... ..

This setup file will be supplied to the end-user.

easyPublish.

EXE

Set 2: Create register ID for end-user.
When the end user install the setup and before the project opened, they will be asked to input

correct register ID.
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hchine eode: 1306445202
Fegister coda: |
Ragister
3

This Register code is create by the software included in the easySCADA.

|, easyScada

i easyManitor

53 easyServer

| Manual
I i Register
€3 ScriptEdit
ShowCommData
i3 Uninstall easyScada

You can click the “Register” button,

i Register ﬁ
Project name ITest L‘
Fublisher id |enf1234
Uzer machine code |13‘354452‘32|
User register code I

et
~ ¥

In the above “Register” dialog box, you need select the project name, then the publisher ID
will be pop out automatically, then you input the user machine code(the end user supply to
you). And Click the “Get” button.
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i Register l M

Froject name ITest .ll
Publisher id lcnf1234
User machine code |1395445292
| User register code |5EIZI:IEII'EITEI4
Get

Now you can send the register code to the end user.

Step 3: The end user input the register code and click register button, then the project can be

opened.

1 Register -ﬂ M
e R 1306445202
Recutes e M

| Ragister

i ——

easyExplorer

Registration successl
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V. 1.04

EasyLine AHU

—AHU 1 — [AHU 2 — System ———————————=—
Active || Active On/Off .
Control % / Control % / Pum &
Room%RH IEHL' Room %RH IEHL' % mapx RPM IEHH
Alarm High %RH © | | Alarm High %RH ' '
Alarm Low %RH Alarm Low %RH 3 i

Time f. service
Duct%RH 234 | Duct%re  i23M
Alarm %RH ‘?@‘ Alarm %RH ?ﬁ
Alarm
Step aep High flow
Valve 1 Valve 1 High RPM
Valve 2 Valve 2 Freg. Inv.
Valve 3 i Valve 3 External
Solenoid valve clicks Solenoid valve clicks Hours
Valve 1 @Clickl Valve 4 @Click4 System @Hours_sys
Valve 2 @Click2 Valve 5  @Click5 Pump  @Hours_pump
Valve 3 @Click3 Valve 6 @Click6 Oil @Hours_oil

Duct AHU1 & !EEH Inlet %RH IEHH Solenoid valve clicks
Valve 4 @y
Room AHU1 2 834 Inlet 7 ic3H Valve 5 @Clicks

Valve e @Clické

REVISION RECORD

Revision Description

2014.5.8 3.3.19 Report table of easyMonitor report object is available now.
2014.12.23 Fan object is available!

2015.7.28 The projects can be compiled for end-users now, the description is added in

1.6.1 compile..

Data input object added in 3.3.33

Logic function bitmap switch added in 3.3.34
Instant on button object added in 3.3.35
Flow object added in 3.3.36

Flatflow object added in 3.3.37
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Instant on button object added
GPRS upload function added in chapter 5.

2017.6.13

Chapter 6 How to export a setup for end user
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